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Introduction

This document includes information about servicing the Color Controller E-45A. In this document, the Color Controller E-

45A is referred to as “the E-45A.”

Document conventions

Note: The NOTE format highlights important messages and additional information.

About the E-45A

The E-45A adds computer connectivity and highly efficient PostScript and PCL printing ability to the Pro C7200 series 

printer.

With the E-45A, customers can use the printer as a PostScript printer and scanner. Once it is connected to the printer 

through the network, customers can print to the E-45A from supported client computers on the network.

The E-45A ships with software pre-installed so that customers can use it immediately. However, as part of servicing the E-

45A, you may need to reinstall software.

How the E-45A operates

When a customer prints, the motherboard and printer interface board process image data. The printer interface board is a 

custom board and allows the E-45A to communicate with the printer. The CPU controls the transfer of image data to and 

from the motherboard and runs the PostScript interpreter. DIMMs hold image data during printing.

The interpreter rasterizes the page description file and compresses the image pattern into memory using compression 

technology. The interpreter outputs the compressed raster data through the image frame buffer memory to the printer 

interface board. The raster data is sent to the printer, which then renders the image on paper at maximum speed.

Before you service the E-45A

Before you service the E-45A, it is strongly recommended that you make sure that you have the required tools (page 10) 

and carefully review all precautions.

Warning: The WARNING icon indicates a warning concerning operations which, if not performed correctly, may 

lead to death or injury. To use the E-45A safely, always pay attention to WARNING icons and messages.

Caution: The CAUTION icon indicates a caution concerning operations which, if not performed correctly, may lead 

to injury. To use the E-45A safely, always pay attention to CAUTION icons and messages.

Important: The IMPORTANT icon indicates operational requirements and restrictions. To operate the E-45A 

correctly and avoid damage to the E-45A or other property, always pay attention to IMPORTANT icons and 

messages.
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Also, keep in mind that the most common cause of a hardware problem is a faulty or loose connection. Before you replace 

an expensive component, check internal and external connections (see page 46).

Tools you will need

To install or service the E-45A, you will need the following tools and parts:

• ESD wrist grounding strap and antistatic mat

• Flathead screwdriver

• #0, #1, and #2 Phillips head screwdrivers

When servicing the Fiery QuickTouch, use a screwdriver with a magnetic tip.

• Needlenose pliers

• The E-45A documentation, including the customer media pack and any related service bulletins

Precautions

This section includes information about how to safely operate and service the E-45A and how to avoid damage to E-45A 

components.

Report shipping damage

If there is evidence of shipping damage, save the shipping boxes and damaged parts. Call the shipper immediately to file a 

claim and notify your authorized service/support center.

Do not change an existing network

The E-45A is probably connected to an existing Local Area Network (LAN) based on Ethernet hardware. The network is 

the link between the customer’s computer, existing laser printers, and other prepress equipment. Never disturb the LAN by 

breaking or making a network connection, altering termination, installing or removing networking hardware or software, 

or shutting down networked devices without the knowledge and express permission of the site administrator.

Do not assign an IP address to the E-45A

Only the site administrator should assign an IP address to a network device, including the E-45A. If you enter an incorrect 

IP address for the E-45A, errors may occur on connected devices.

Handling boards

When handling a printed circuit board, do not bend it. Hold it by opposing edges, rather than by the corners.

Handling the hard disk drive

To ensure that you do not damage the hard disk drive, do the following:

• Follow electrostatic discharge (ESD) precautions.

Important: Avoid touching magnetic tools to storage media such as hard disk drives. Contact between magnetic 

tools and magnetic storage media may result in data corruption.
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• Keep magnets and magnetic-sensitive objects away from the hard disk drive.

• Do not loosen or remove the screws on the top of the hard disk drive. Doing so voids the warranty.

• Handle the hard disk drive by its sides and avoid touching the printed circuit board.

• Do not drop, jar, or bump the hard disk drive.

• Before you remove or install a hard disk drive, allow it to reach room temperature.

Avoid magnets

Keep magnets and magnetic-sensitive objects away from electronic components, especially the hard disk drive.

Avoid fan blades

Attention : ce produit contient des pièces mobiles dangereuses. Veuillez le maintenir à l'écart des pales de ventilateur lors 

de sa maintenance.

Attenzione: questo prodotto include parti mobili pericolose. Mantenere la distanza dalle pale della ventola quando sono in 

uso.

Warnung: Dieses Produkt verfügt über gefährliche Teile, die sich bewegen. Halten Sie bei der Instandhaltung Abstand zu 

den sich bewegenden Ventilatorblättern.

Advertencia: Este producto contiene piezas móviles peligrosas. Cuando realice el mantenimiento de este producto, 

manténgase alejado de aspas de ventilador en movimiento.

Waarschuwing: dit product bevat gevaarlijke bewegende delen. Blijf uit de buurt van bewegende ventilatorbladen bij het 

uitvoeren van onderhoudswerkzaamheden aan dit product.

Aviso: este produto contém peças removíveis perigosas. Ao realizar a manutenção deste produto, mantenha-se longe das 

lâminas removíveis do ventilador.

Use caution with sharp edges

The edges of some E-45A components are sharp.

Electrostatic discharge

When you work with electronic components, electrostatic discharge is a concern since it can destroy circuits, or damage 

them, reducing their life span. The area around the printer is most likely not static-free, and electrostatic discharge could 

occur. 

Do the following to avoid damage due to electrostatic discharge:

• Work on a grounded antistatic mat.

Warning: The E-45A contains hazardous moving parts. When servicing the E-45A, keep away from moving fan 

blades.
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• Wear an antistatic wristband, attached to the same location as the antistatic mat.

• Before you remove an electronic component from the shipping box, touch a metal area of the printer to discharge static 

from your body.

• After you remove an electronic component from the shipping box, place it face up on a grounded antistatic surface.

• Leave electronic components in antistatic bags until you are ready to use them.

• Do not walk on carpet or vinyl while carrying an electronic component, unless it is in an antistatic bag.

• If you remove an electronic component from the printer, immediately place it in an antistatic bag.

The power cable

Observe the following guidelines:

• Only use the power cable that shipped with the E-45A or an appropriate replacement power cable. For replacement 

parts, see your authorized service support center.

• Before you open the E-45A, unplug the E-45A.

• Keep the power cable away from foot traffic.

• Do not place objects on the power cable.

• Do not plug the E-45A into a 2-hole, ungrounded outlet by means of a 3-prong adapter.

• Do not plug the E-45A into a circuit connected to heating or refrigeration equipment (including a water dispenser).

• Do not plug the E-45A into a switchable outlet.

• Do not pull the cable to unplug the E-45A. Instead, pull the plug.

• Do not tamper with or disable the power cable grounding plug.

• Do not use an extension cord.

Do not bring liquids near the E-45A

If liquid spills on the E-45A, immediately unplug the E-45A.

Do not open the power supply

For more information about the power supply, see “Power supply” on page 78.

Do not open the hard disk drive

For more information about the hard disk drive, see “Hard disk drive” on page 80.
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Power supply cord notice

Lithium battery notice

Short circuit protection

Important: The power supply cord is used as the main disconnect device. Ensure that the power outlet is located/

installed near the equipment and is easily accessible.

Caution: There is a danger of explosion if the battery is replaced with an incorrect type. Replace a battery only with 

the same type recommended by the manufacturer. Dispose of used batteries according to local regulations.

Warning: This product relies on the building’s installation for short-circuit (overcurrent) protection. Ensure that a 

fuse or circuit breaker no larger than 120 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase 

conductors (all current-carrying conductors).
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About the installation process

It is strongly recommended that you review this chapter before you install the E-45A. Also keep in mind that installation 

problems are easier to avoid and diagnose if you proceed from the component level to the system level, verifying 

functionality at each step.

Since the E-45A is connected to the customer’s network, be sure to coordinate your installation schedule with the 

administrator at the customer site. For information about network setup, refer the site administrator to 

Configuration Guide, which is part of the user documentation set.

If necessary, you can change the default language of the E-45A set at the factory (see “To change the E-45A language” on 

page 15).

Note: You can change the default language that is preinstalled at the factory using the Configure tool available through 

Command WorkStation and WebTools. Start Configure, choose Fiery Server > Regional Settings. From the Server 

Language list, select your language and then click Save. When an Alert dialog box appears, click Continue. It takes up to 

15 minutes to change languages.

You can also change the default language using the Fiery Quick Touch menu. Select Quick Launch > Settings, and log in to 

the server as admin. From the language drop-down list, select the your language, save the changes, and then reboot the 

server. It takes up to 15 minutes to complete the language changes. 

To install the E-45A

1 Check installation requirements and verify site conditions.

If possible, obtain verification that the network is operational (see page 15).

2 Unpack the E-45A (see page 17).

3 If applicable, connect the monitor, keyboard, mouse, and furniture to the E-45A.

For more information on setting up the furniture, see the documentation that comes with the furniture kit. 

4 Connect the following cables (see page 18).

• Network cable (upper RJ-45)

• Crossover Ethernet cable (lower RJ-45)

5 (Optional) If the E-45A requires a static IP address (for example, in a non-DHCP network environment), work with the 

site administrator to configure a static IP address.

6 Complete the installation (see page 27).

Remind site administrator to install current user software on client computers that print to the E-45A (see Printing and 

Utilities, which are part of the user documentation set).
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To change the E-45A language

1 Access Configure (see page 30).

2 In Configure, click Fiery Server > Regional Settings,

3 In the Server Language drop-down list, select a language.

4 Click Save.

5 Click Continue, then click Reboot. 

Wait until the E-45A reboots and becomes Idle. It may take up to 15 minutes to complete the system language change.

Checking the customer site

Before you install the E-45A, check site conditions and inform the customer of any installation requirements.

Figure 1: Space requirement for the E-45A without optional furniture

Printer readiness

• Is the printer configured for use with the E-45A? (For the proper settings, see the documentation that accompanies the 

printer.)
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2 E-45A

3 Connector panel

4 Side panel

5 Fiery Quick Touch display panel

6 Front panel

1

3

4

1 2
2

1

3 6

6

5

Top view Left view
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• Is space available near the printer for the E-45A and the optional furniture?

Make sure that adequate space is available for the E-45A and the furniture. Allow enough space at the connector panel 

for the cables to route easily and at the side panel so that the E-45A does not interfere with use of or service to the 

printer (such as clearing a paper jam). You may need to move the printer away from the wall so that the interface 

connectors are accessible. 

• Does the printer require service or adjustments?

Print the printer Test Page before you install the E-45A.

If the image indicates that the printer needs adjustment, inform the customer. After getting approval, complete the 

necessary printer service. 

Power

• Is a dedicated, grounded electrical outlet for the E-45A available near the printer?

Locate the grounded electrical outlet that will supply power to the E-45A. Do not run the E-45A and the printer on the 

same circuit. If the customer has provided one, use a surge suppressor for the E-45A.

Network

• Make sure that the network is available at the time set for installation.

• Verify with the network administrator that the network is functioning before you attach the E-45A. 

• Make sure that the configuration requirements specified in Configuration and Setup (which is part of the user 

documentation set) have been met for remote computers and the network. 

Setting customer expectations

When the site is ready, installation of the E-45A takes about one hour. Inform the customer of the following:

• Some nodes on the network may be unavailable for up to one hour.

• The printer may be unavailable for up to one hour.

• The network administrator must be available during the installation for network connectivity.

Equipment downtime and impact on the network can be minimized if the network administrator installs a network 

connector for the E-45A and confirms network functionality with the connector in place before the date scheduled for 

the E-45A installation.

• The network administrator must make a networked computer available during the installation. The appropriate 

software must be installed in advance. Documentation for the networked computer and network operating software 

should be available.
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• The network administrator must install the user software shipped with the E-45A onto networked Windows and 

Mac OS computers that print to the E-45A (user documentation is also included). 

Note: This document covers hardware installation and service and provides general information about connecting the E-

45A to the customer’s network. Network Setup and configuration information exceeds the scope of this document. 

For Network Setup and configuration information, refer the network administrator to Configuration and Setup, which is 

part of the user documentation set.

Unpacking the E-45A

The E-45A is assembled and shipped from the factory with all necessary cables (except the network cable) and 

documentation.

Before you unpack the E-45A, it is strongly recommended that you review all “Precautions” on page 10 to avoid injury or 

damage to the E-45A.

• The E-45A weighs approximately 20Kg. Be careful when moving the device.

To unpack the E-45A

It is strongly recommended that you save all packing materials in case you need them later (for example, if you discover 

something is damaged and need to return it). Do not immediately discard packing materials.

1 Open the box and remove the packing material.

Save the original boxes and packing material, in case you need to transport the E-45A at a later date.

2 Remove the contents from the top container. Inspect the contents for visible damage. 

3 Set aside the remaining components from the top container.

4 Remove the top container and any packing material.

5 Carefully lift the E-45A out of the box.

If you notice shipping damage to any component, save the shipping container, in case the carrier needs to see it. Call the 

carrier immediately to report the damage and file a claim.

6 Give the media pack to the customer or network administrator.

Let the customer or network administrator know that in order to take full advantage of the E-45A, the user software 

must be installed on computers that will print to the E-45A.
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7 Locate the EFI/Fiery decal in the shipping container and affix it to the printer as shown.

Figure 2: Affixing the decal to the printer

Connecting the E-45A 

You are now ready to make the following connections:

• (Optional) Keyboard, monitor, and mouse

• (Optional) Fiery NX Station furniture

Note: The Fiery NX Station furniture kit includes documentation for assembling the furniture.

• Power cable 

• Network cable 

• Crossover Ethernet cable (lower RJ-45)

• (Optional) USB cable with Type A and B connectors for power synchronization (see page 25)

For more information on connecting cables, see page 45.

1 EFI/Fiery decal

1



19Installation and Service Guide: Color Controller E-45A

Installing Hardware

Figure 3: Front and connector panel

A Front panel B Connector panel

1 Fiery QuickTouch LCD 6 Power connector 12 Type A USB3 ports (x2)

2 Type A USB 3.0 ports (x3)

Note: Do not use the USB ports on 

the Fiery QuickTouch for keyboard/

mouse connections for the service 

purpose.

7 Power switch
|: Power On
O: Power Off

13 Crossover Ethernet cable port 
(Lower RJ-45)

8 Type A USB 2.0 ports (x2) 14 Printer interface board

3 Fiery QuickTouch reset button 9 Network port (Upper RJ-45) 15 Type B USB port for power 
synchronization

4 Power button 10 Display port (for optional 
monitor)

16 OFF/ON switch for power 
synchronization
ON: Right
OFF: Left5 Front panel door 11 DVI port to the printer touch 

panel (for optional monitor)

17 (Optional) Printer interface 
board 

1 4

2 6

7

11

12 13

A B

3

5

14

15 16

17

8 9

10
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Figure 4: Inside the front door

1 DVD drive (inside behind door)

2 Eject button (inside behind door)

1

2
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(Optional) Connecting the monitor, keyboard, mouse, and power

Note: Before using the E-45A, connect the monitor, keyboard, mouse, and power to the E-45A if applicable.The Fiery NX 

Station is an option.

To connect the monitor, keyboard, mouse, and power

Note: For detailed information about the monitor, keyboard, and mouse, see the documentation that accompanies those 

products.

1 Make sure that the E-45A is installed in the furniture and that the monitor is securely attached to the top of the E-45A.

For more information, see the assembly instructions that accompany the furniture.

2 Connect the monitor cable to the DVI port or Display port on the connector panel.

3 Connect the monitor power cable to an outlet of the power strip inside the furniture, or an outlet on the wall.

4 Place the keyboard and mouse on the furniture table top.

5 Connect the wireless adapter for the keyboard and mouse to one of the USB ports.

Use the USB ports that is attached at the front of the furniture. 

6 Power on the mouse by using the power switch on the bottom side of the mouse.

7 Connect the recessed end of the E-45A power cable to the power connector on the power strip inside the furniture.

Be sure to use the appropriate power cable for your regional outlet type.

Connecting to the printer and the network

Connect the E-45A to the printer and the network to enable print and network connectivity.

To connect to the printer

1 Make sure that the E-45A and the printer are powered off.
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2 Connect the crossover Ethernet cable to the lower RJ-45 port on the E-45A and the printer.

Figure 5: Straight-through and crossover Ethernet cables

Note: To prevent risk of cross-talk, make sure the crossover Ethernet cable does not touch the power cables for the 

system. Image quality problems or E-45A shutdowns could result.

Figure 6: Printer and E-45A cable connection

To connect to the network

1 Make sure that the E-45A is powered off.

2 Make sure that the network cable is connected to the customer site network.

3 Connect the network cable to the upper RJ-45 network port on the back of the E-45A.

The E-45A provides twisted pair connectivity to an Ethernet network. When the network cable is connected, the 

Ethernet interface automatically detects the speed of the network environment. Depending on your network speed, the 

following unshielded twisted pair (UTP) network cables are supported:

• 10BaseT: Category 3 or higher

• 100BaseTX: Category 5 or higher (4-pair/8-wire, short-length)

• 1000BaseT: Category 5e or higher (4-pair/8-wire, short-length)

Important: The straight-through network cable at the customer site and the crossover Ethernet cable included 

with the E-45A look similar, but are not interchangeable. Make sure that you connect the crossover Ethernet cable 

to the lower RJ-45 port on the E-45A connector panel. 

1 Straight-through cable: wire arrangements are identical on both connectors

2 Crossover Ethernet cable: wire arrangements are different

Note: Align cables side by side and examine wires.

1 2 3 4 1 2 3 4

1 2 3 4 3 4 1 2

=

=

1

2
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After power on, the network administrator should perform Network Setup, verify the network connection, verify that the 

E-45A appears in the list of printers, and then print a few test documents from a networked computer that will use the E-

45A. For more information, see Configuration and Setup, which is part of the user documentation set.

Starting the E-45A for the first time

This section describes how to start the E-45A for the first time after connecting the cables. 

To start the E-45A 

1 Make sure that the power switch on the back of the E-45A is in the ON (|) position. 

Figure 7: E-45A power switch

2 Power on the E-45A using the power button ( ) on the front panel.

Press once and release the button to power on the system. The power supply automatically senses the correct voltage.

Figure 8: E-45A power button

Important: The straight-through network cable at the customer site and the crossover Ethernet cable included with 

the E-45A look similar, but are not interchangeable. Make sure that you connect the network cable to the upper RJ-45 

port on the E-45A connector panel (see page 45).

1 Power switch

1 Power button

1

1
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3 Check the activities on the Fiery QuickTouch.

The power supply automatically senses the correct voltage. Allow startup to proceed without interruption. Do not press 

any buttons while the system is starting.

Configuring a static IP address for the E-45A

If the customer requires the E-45A to be configured with a static IP address (for example, in a non-DHCP network 

environment), obtain a valid static IP address from the network administrator and configure the E-45A.

To configure a static IP address for the E-45A 

1 Press Home button on the printer operational panel.

2 From the Home screen of the printer touch panel, select Fiery. If the Fiery icon does not display, press the button on the 

upper right corner of the screen to switch to the icon view. 

3 Press the Fiery tab.

4 Press Setup.

5 On the Login screen, press Password. Enter Fiery.1. Press OK.

Type Fiery.1 exactly as shown. The password is case-sensitive; for example, fiery.1 will not work.

6 On the Setup screen, do the following:

• Press WINS. If enabled (yellow), press Use WINS to disable this feature. Press Save.

• Press DNS. If enabled (yellow), press Get DNS address automatically to disable this feature. Press Save.

• Press IP Address. Enter an IP address. Press Save.

• Press IPv4 Address. Press Manual Configuration.

7 On the Manual Configuration screen, do the following:

• In the IP Address field, enter an IPv4 address. Press OK.

• In the Subnet Mask field, enter a subnet mask IP address. Press OK.

• In the Default gateway field, enter a default gateway IP address. Press OK.

• When done, press Save. Press Go Back.

8 On the Setup screen, press Exit Setup.

9 Press Reboot Now.

To configure a static IP address for the E-45A using the Fiery QuickTouch

1 On the Fiery QuickTouch display screen, press the Quick launch icon on the bottom-left corner.

2 Select Settings, and log in to the server as admin user (the default password is Fiery.1). 
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3 Select Configure IP Address, and select IP Address, DNS, Subnet Mask, WINS, and Default Gateway, as necessary. 

4 Save the settings and exit. 

Enabling the power synchronization

During the installation, enable the power synchronization feature by using the OFF/ON switch on the printer interface 

board, and the USB power cable included in the accessory kit. The default switch position is OFF. 

When you enable power synchronization, the E-45A synchronizes power with the printer’s main power off/on status. If the 

printer powers off, the E-45A receives signals from the printer through the USB cable connected to the printer interface 

board, and automatically starts the shutdown process. If the E-45A receives the startup signals from the printer, the E-45A 

automatically powers on and begins the startup sequence. 

To enable the power synchronization feature at the E-45A

1 Shut down the E-45A (see page 35) and the printer.

2 Remove the port cover that is attached to the Type B USB port on the printer interface board.

3 Locate the USB cable in the accessory kit that comes with the E-45A. 

4 Locate the USB cable that shipped with the printer. 

Important: After the power synchronization is enabled, make sure to control the E-45A power using the printer.
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5 Connect one end of the USB cable (Type B) to the port on the printer interface board of the E-45A. Connect the other 

end of the cable (Type A) to the USB port on the printer.

Figure 9: USB connection between printer and E-45A

6 Set the switch on the printer interface board to the ON position.

7 Power on the printer.

The E-45A automatically starts up.

To disable the power synchronization

1 Turn off the printer using the main power switch.

Wait until the E-45A shuts down.

Important: DO NOT use the USB port on the lower printer interface board (optional) when you connect the USB 

cable. The lower printer interface board does not support the power synchronization. 

A printer connector panel B E-45A connector panel

1 Type A USB ports 3 Type B USB port on the main printer interface board

2 USB cable 4 Switch on the main printer interface board: 

OFF position (default)

Important: Do not change the switch position when the E-45A is powered on. 

1
4

A B

32
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2 Make sure that the power switch on the connector panel of the E-45A is OFF position (|).

3 Set the switch on the printer interface board to the OFF position. 

4 Disconnect the USB cable from the USB Type B port on the printer interface board, and from the USB Type A port on 

the printer connector panel. 

5 Start the E-45A (see page 41).

Completing the installation

To complete the installation of the E-45A at the customer site, do the following:

1 Print the Test Page and Server Configuration page (see “Printing E-45A pages from the monitor, keyboard, and mouse” 

on page 29).

2 Ask the customer to verify the output. 

3 Perform any required system upgrades. For instructions, see the documentation that accompanies the system upgrade.

4 Ask the site administrator to perform Setup and print some test documents over the network.

5 Store the output and the current Server Configuration page(s) near the printer.

6 After the site administrator completes Setup, use the Fiery System Installer to copy the contents of the E-45A hard disk 

drive to an image file.

Fiery System Installer is provided in System Software DVD 1. For detailed instructions, see “Using Fiery System 

Installer” on page 94.

7 Inform the site administrator that E-45A user software must be installed on networked computers that print to the E-

45A.

8 Ask the site administrator to make sure that all media shipped with the E-45A is stored in a safe location, accessible to 

you.

9 For additional installation instructions, see the service documentation that accompanies the E-45A.

Important: Do not change the switch position when the E-45A is powered on. 
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Using the E-45A

The following user interfaces are available for the E-45A:

• Fiery QuickTouch on the front of the E-45A

Fiery QuickTouch is the seven-inch LCD color touch screen interface for the E-45A. 

• Fiery NX Station, including a monitor, keyboard, and mouse.

• The printer touch panel

• (Optional) Monitor, keyboard, and mouse of the Fiery NX Station 

Note: The Fiery NX Station (monitor, mouse, and keyboard) is provided as an option feature.

Fiery Ticker

When you log on to the E-45A using the monitor or Remote Desktop Connection, Fiery Ticker automatically starts 

showing the status bar.

Figure 10: Fiery Ticker status bar

You can perform the following tasks using the Fiery Ticker:

• Monitor the activities of the E-45A and printer using the Fiery Notes.

• Manage the E-45A by using Command WorkStation or WebTools

• Shut down, restart, or reboot the E-45A

For details, see the Fiery Ticker Help. To access the Fiery Ticker Help, click “>>” icon at the upper left corner of the 

screen, and select Help.

Printing E-45A pages from the monitor, keyboard, and mouse

This section describes how to print the Test Page, Server Configuration page, and other Fiery pages. 

• Test Page verifies that all components of the E-45A-to-printer interface work. The Test Page is a color file that resides 

on the E-45A hard disk drive.

Note: Information regarding Test Page refers to PS Test Page or PCL Test Page. For more information, see 

Configuration and Setup, which is part of the user documentation set.

Menu 
Access
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• Server Configuration page provides general information about the hardware and software configuration of the E-45A, 

the customer’s current settings for Setup, the current calibration, and the IP address of the E-45A.

Printing the Server Configuration page can be helpful during installation, Setup, and service. After installing the E-45A 

(including connecting to the network) and before default settings are changed in Run Setup, you can obtain a record of 

the defaults by printing the Server Configuration page. 

To print E-45A pages

1 At Fiery Ticker screen, click “>>” icon on the upper left corner, and choose Print Pages.

The Print Pages sub-menu displays the list of available E-45A pages.

2 Choose the page that you want to print from the sub-menu.

The E-45A sends the selected page to the printer.

3 If you printed the E-45A Test Page, examine the quality of the Test Page from the printer.

If the Test Page prints, you know the E-45A is functional and the connection between the E-45A and the printer is 

working. If the Test Page fails to print, look up printing problems in “Table 4: E-45A error messages and condition” on 

page 112. 

When you examine the Test Page, keep in mind the following:

• All color patches should be visible, even though they may be very faint in the 5% and 2% range.

• Each color’s patch set should show uniform gradation from patch to patch as the color lightens from 100% to 0%.

Poor image or color quality may indicate a need to calibrate the system or service the printer. Information on the Test 

Page includes the date and time of the last calibration so the Test Page can be kept for future reference. For more 

information, look up printing problems in “Table 4: E-45A error messages and condition” on page 112, or see Color 

Printing, which is part of the user documentation set.

Command WorkStation

As an E-45A service technician, you will typically log on to the system as Administrator. For more information about using 

Command WorkStation, see Command WorkStation Help.

About Configure

You can access Configure from Command WorkStation or WebTools. For information about using Configure, see the 

Command WorkStation Help.

To access Configure from an Internet browser

1 Open an Internet browser and type the IP address of the E-45A.

2 In WebTools, click Configure icon on the left. 

3 Log on with Administrator privileges.
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To access Configure from Command WorkStation

1 In Command WorkStation, as Administrator, do one of the following:

• In the Server menu, click Configure.

• From the SERVERS list, right-click the E-45A and select Configure.

• In Device Center, on the General, click Configure button in lower right corner. 

2 If the Fiery Setup dialog box displays, click Configure.

If you have not completed initial setup, you may want to click Fiery Setup Wizard instead. For more information, see 

Configuration and Setup.

If you use the Fiery Setup Wizard (from Command WorkStation or WebTools) and click Finish at the end of the wizard, 

the Fiery Setup dialog box does not display again in any location.

Using the E-45A on Fiery QuickTouch

The Fiery QuickTouch on the front of the E-45A allows you to do the following:

• View print job status and alerts

• Use Fiery System Restore to back up and restore the E-45A

• Replace the motherboard (when the motherboard replacement dongle is inserted into a USB port)

• View the IP address of the E-45A

• Shut down, restart, or reboot the E-45A (see page 41).

Note: You can also shut down and restart the E-45A through the printer touch panel (see page 36).

• Interact with the E-45A during software installation and initial setup (see page 98)

• Run certain diagnostics (for service purposes only)
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Figure 11: Fiery QuickTouch touch panel features

1 Touch panel 3 USB 3.0 ports

2 Power button 4 Fiery QuickTouch Reset button (requires pin)

1
2

3

4
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Overview of Fiery QuickTouch menu options

The following options are available from the Fiery QuickTouch main menu:

Figure 12: Fiery QuickTouch Home screen

The Home screen is the main interface for job status, and displays various screen elements.

The Queue job list shows queued jobs and detailed information about each job.

1 E-45A name and status

Tapping the Fiery icon shows more information about the 
E-45A and the network address.

6 Number of pages and copies that are printing

2 Icon of the print job type

If there are no print jobs being processed, an Idle status 
displays.

7 Queued jobs list

Tapping the Queue icon shows a list of jobs that are queued.

3 Printing progress of the active print job 8 Printed jobs list

Tapping the Printed icon shows the printed jobs list.

4 File name of the active print job 9 Quick Launch

The Quick Launch button displays additional applications.

5 Time left to complete the active print job 10 Shows consumables

11 Quick Options and current local time

1

2 3

4

5

6

7 8

9

11

10
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Figure 13: Queue job list

The Printed jobs list provides job status and details about the jobs that have been printed.

Figure 14: Printed jobs list

In either the Queue jobs or Printed jobs screen, you can tap Back to go back to the Home screen.
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Quick Launch menu

From the Home screen, you can tap the Quick launch icon on the bottom-left corner of the screen to access the following 

menus:

• Fiery System Restore

• Settings

• About Fiery

• Print configuration

• Diagnostics (The Diagnostics application icon appears when you insert a diagnostics DVD.)

• Motherboard replacement (The Motherboard replacement application icon appears when you insert the motherboard 

replacement dongle.)

Figure 15: Quick launch menu

Tapping the Home icon takes you back to the Home screen. Before accessing Fiery System Restore or Settings, you must 

log in as an administrator.

For more information on backing up and restoring the E-45A, see “Using Fiery System Restore” on page 92.

Quick options

The Quick Options menu can be accessed by tapping the three-dot icon on the top-right corner of the Home screen. Quick 

Options provide the following general system settings:

• Shutdown system: shuts down all Fiery server software and powers off the system.
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• Reboot system: shuts down all Fiery server software and reboots the system.

• Restart Server: resets the Fiery server software, but does not reboot the entire system.

• Brightness: sets the brightness level of the Fiery QuickTouch screen.

Figure 16: Quick options menu

Using the printer touch panel

The “EFI Fiery” icon of the printer touch panel allows you to interact with the E-45A from the printer. The menus provide 

access to many of the same options available from Command WorkStation. 

Figure 17: The printer touch panel

To access to the Fiery screen on the printer touch panel

1 Press Home button on the printer touch panel.

Main

Waiting Jobs:

Idle

Paper Tray Status:

Document 3

Document 4

Document 1

Document 2

Printed Jobs:

Suspend Printing

LoginJob ListPrintMe Tools Scan
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2 From the Home screen of the printer touch panel, select EFI Fiery. If the EFI Fiery icon does not display, move to the 

other screen by swiping the touch screen until the EFI Fiery icon appears. 

3 Press the Fiery tab.

Main tab 

The Main tab is displayed as the starting point. It summarizes waiting and printed jobs and displays paper tray status and 

other information. 

PrintMe tab

The PrintMe tab allows you to submit print jobs using Document IDs if you have a PrintMe subscription. For more 

information, see Printing Guide.

Note: PrintMe cloud printing must be enabled in Configure for the PrintMe tab to display in the menu.

Job List tab 

The Job List tab on the printer touch panel provides access to jobs according to the status of the job, similar to the Active 

and Printed Jobs windows in Command WorkStation. The lists are as follows: 

To change from one list to another, press the desired tab at the bottom of the printer touch panel.

On each of these lists, you can scroll up and down one line at a time, or advance to the top or bottom of the job list. Select 

a job, and choose the appropriate button to Print, Print and Hold, Delete, or display the Properties of the job. On the 

Properties tab, you can change the number of copies, but not any other job properties. 

Suspend 

Printing

Suspend print activity between the E-45A and the printer. Use this command to 

interrupt the current E-45A job, for example, to perform maintenance tasks. Jobs 

continue to process on the E-45A. After you complete maintenance tasks, choose 

Resume Printing to continue printing jobs from the E-45A.

Resume 

Printing

Resume print activity between the printer and the E-45A after you select Suspend 

Printing. 

Active Jobs currently waiting to print.

Held Held jobs.

Printed Printed jobs.

Secure Allows you to log on to display secure print jobs. 
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Tools tab

The Tools tab allows you to perform tray alignment and calibration. 

Scan tab

The Scan tab allows you to scan documents. For more information, see Utilities.

Fiery tab

The Fiery tab provides access to many of the same features available through Command WorkStation.

Tray Alignment Adjust the placement of text and images on a page so that they are correctly aligned on 

the sheet of paper and both sides of a duplex sheet have the exact same alignment. For 

more information about this function, see Utilities.

Calibration Calibrate the E-45A using ColorCal. For more information, see Color Printing. 

Fiery Info Displays information about the current configuration of the E-45A.

Printable Info Allows you to print these system pages from the E-45A:

PS Test Page/PCL Test Page: Confirms that the E-45A is properly connected to the printer, and 

provides color and grayscale samples to troubleshoot problems with the printer or the E-45A. Settings 

on the Test Page may include: Server Name, color settings, printer model, and date and time the Test 

Page was printed.

PS Font List/PCL Font List: Prints a list of all fonts currently on the E-45A hard disk drive.

Configuration: Provides general information about the hardware and software configuration of the E-

45A, the current settings for Setup, the current calibration, the IP address of the E-45A, and a log of 

system updates. 

Color Charts: Prints samples of the RGB, CMY, and PANTONE colors available from the E-45A. 

Custom Paper Instructions: Provides the instructions for setting up custom paper entry.

Calibration Instructions: Prints the information on how to perform the calibration.

Job Log: Prints a log of the last 55 jobs.

E-mail Log: Prints a log listing recent e-mail activity. 

FTP Log: Prints a log listing recent FTP activity.

To print the E-mail or FTP log, you must first enable the appropriate service.

Setup Enter the Setup menu and change Setup option settings. 

Clear Job Log Clears the job log from the E-45A.
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Printable Info menu

This section describes how to print pages such as the Test Page and Configuration page from the Printable Info menu 

(described on page 38). The Printable Info menu is accessed through the Fiery tab (see page 38).

Printing the Configuration page can be helpful during installation, Setup, and service. After installing the E-45A 

(including connecting to the network), and before default settings are changed in Run Setup, you can obtain a record of the 

defaults by printing the Configuration page. 

Before you perform any service procedure, you should print the E-45A Configuration page, if possible, so you are prepared 

to return the settings to their former configuration, if necessary. 

Printing the Test Page indicates that the E-45A is functional and that the connection between the E-45A and the printer is 

working. 

To print a page from the Printable Info menu

1 If it is not powered on already, power on the printer and allow it to warm up. 

2 If it is not powered on already, power on the E-45A using the power button on the front panel and allow it to start up 

completely (approximately three minutes).

3 Make sure that Idle appears on the Fiery Main menu.

If Busy or Printing appears, the E-45A is processing and you must wait until Idle appears.

4 Touch the Fiery tab.

Run 

Diagnostics

To troubleshoot printer interface board, choose this menu. 

Clear Server Clear all jobs in all server queues, as well as all jobs archived on the E-45A hard disk drive, the index 

of archived jobs (in the Archive window), all FreeForm masters, and the index of FreeForm masters 

(in the FreeForm window). Consult with your administrator or operator before choosing Clear Server. 

Restart Fiery Shut down all E-45A activity in the correct manner and then restart. The following options are 

available from the submenu that appears:

Restart Fiery Service: Resets the server software but does not reboot the entire system. Network 

access to the E-45A is temporarily interrupted and all currently processing jobs are aborted and may 

be lost.

Restart System: Shuts down and then reboots the E-45A. Network access to the E-45A is terminated 

and all currently processing jobs are aborted and may be lost.

Shut Down: Shuts down all E-45A activity properly.

Note: For Shut Down option to function correctly, the power synchronization feature must be disabled (see 

page 24).
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5 Touch Printable Info and then select the page that you want to print.

The E-45A sends the selected page(s) to the printer. 

6 If you printed the Test Page, examine the quality of the page.

If the Test Page prints, you know the E-45A is functional and the connection between the E-45A and the printer is 

working. If the Test Page fails to print, look up printing problems in the Troubleshooting table on page 122. 

When you examine the Test Page, keep in mind the following:

• All color patches should be visible, even though they may be very faint in the 5% and 2% range.

• Each color’s patch set should show uniform gradation from patch to patch as the color lightens from 100% to 0%. 

Poor image or color quality may indicate a need to calibrate the system or service the printer. Information on the Test 

Page includes the date and time of the last calibration, so the Test Page can be kept for future reference. For more 

information, look up printing problems on page 122, or see Color Printing from the user documentation set.

Using the Fiery desktop on the printer touch panel

You can access the E-45A desktop from the printer touch panel. 

To access the E-45A desktop from the printer touch panel

1 At the printer touch panel, press the Fiery icon. 

2 Login to the E-45A desktop as Administrator user. 

The default password for the Administrator is Fiery.1 (case-sensitive). 

Network status LEDs

Two LEDs next to the network connector indicate the network link status and speed. For additional information about 

network setup, see Configuration Guide, which is part of the user documentation set.

Figure 18: Ethernet network port (upper RJ-45)

1 LINK/ACTIVITY

2 SPEED

1

2
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Table 1: Network link indicators

Table 2: Network speed indicators

Starting, shutting down, restarting, and rebooting 

The customer will generally leave the E-45A on all of the time. Remember that when the E-45A is powered off, network 

access to the printer is interrupted. Power off the E-45A when you need to service it and before you remove or attach any 

cables to it. 

To start the E-45A

1 Make sure that the power cable is attached and that the power switch is in the ON position (|).

LINK/ACTIVITY LED Network link status

Off No link to network

Solid green Valid link to network

Flashing green Data transfer is in progress

SPEED LED Network speed

Off 10 Megabits/second

Solid green 100 Megabits/second

Flashing green 1000 Megabits/second 

Important: Unless instructed otherwise by a troubleshooting procedure, always shut down the E-45A from the Fiery 

QuickTouch monitor or from the monitor attached to the E-45A. Do not use the power button on the side to shut 

down the E-45A.
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2 Press the power button ( )on the side of the Fiery QuickTouch panel.

3 Check the light on the Fiery QuickTouch.

The power supply automatically senses the correct voltage. Allow startup to proceed without interruption. Do not press 

any buttons on the Fiery QuickTouch while the system is starting.

To shut down, restart, or reboot from the monitor

Note: The Fiery NX Station (including monitor) is optional.

1 Make sure that the E-45A is not receiving, processing, or printing any files.

If the system just finished processing, wait at least five seconds after the system reaches Idle before you proceed.

2 Close all applications except Fiery Ticker.

3 Do one of the following:

• Click the Windows Start button and select Shut Down.

• Click the Windows Start button, click the arrow next to Shut Down, and select Restart.

• Click “>>” icon at the upper-left corner of the screen, and select Server Actions > Restart Fiery or Reboot Fiery. Click 

OK.

4 If you shut down the E-45A, move the E-45A power switch to the off (O) position for maximum energy savings or 

service (wait 10 seconds before you proceed).
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To shut down, restart, or reboot from the Fiery QuickTouch

Note: Notify the network administrator before you remove the E-45A from the network.

1 Make sure that the E-45A is not receiving, processing, or printing any jobs.

If Printing appears on the Fiery QuickTouch, the E-45A is processing. You must wait until the system finishes and 

reaches Idle before restarting or shutting down.

If the system has just finished processing, wait at least five seconds after the system reaches Idle before beginning the 

shutdown procedure.

2 On the Fiery QuickTouch Home screen, tap the Quick options menu button.

3 Make a selection.

• To restart or reboot the E-45A, tap Restart server or Reboot system, respectively.

• To shut down the E-45A immediately, tap Shutdown system.

Allow the system to shut down and power off or restart. 

If you tapped Restart server, you may need to wait one minute or more for the server software to restart.

4 Before accessing internal components following a shutdown, make sure that all cables are disconnected from the back 

of the E-45A.

To shut down, restart, or reboot from the printer touch panel 

Note: Notify the site administrator before you remove the E-45A from the network.

1 Make sure that the E-45A is not receiving, processing, or printing any jobs.

If Printing appears on the Fiery QuickTouch, the E-45A is processing. You must wait until the system finishes and 

reaches Idle before restarting or shutting down.

If the system has just finished processing, wait at least five seconds after the system reaches Idle before beginning the 

shutdown procedure.

If the system has just finished processing, wait at least five seconds after the system reaches Idle before beginning the 

shutdown procedure.

2 Press the Fiery tab.

3 Press Restart Fiery.
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4 At the next screen, select one of the following options:

• Restart Fiery Service (soft reset)—Resets the E-45A server software but does not reboot the entire system. Network 

access to the E-45A is temporarily interrupted and all currently processing jobs are aborted and may be lost. If you 

choose this option, you may need to wait 1 minute or more for the server software to reset.

• Reboot System (hard reset)—Shuts down all E-45A activity properly and then reboots. Network access to the E-

45A is temporarily interrupted and all currently processing jobs are aborted and may be lost.

• Shut Down—Shuts down all E-45A server software and powers off the system. You should always select this option 

when you want to power off the system. Network access to the E-45A is terminated and all currently processing jobs 

are aborted and may be lost.

Note: Use the reset button on the front of the E-45A only if the system is unresponsive to keyboard or mouse actions.

5 Press OK.

Before accessing internal components, make sure that all cables are disconnected from the back of the E-45A.



Replacing parts

Generally, the E-45A requires no regular service or maintenance. Use the procedures in this chapter to inspect, remove, 

reseat, and replace major hardware components.

Overview

This chapter includes information about servicing the following components:

• Boards and cables

• Fiery QuickTouch display module

• Motherboard components (DIMMs, CPU, and battery)

• Fan

• Power supply

• Hard disk drive

• DVD drive

Replacement parts are available from your authorized service representative. The terms “replace” and “replacing” are used 

throughout this document to refer to the reinstallation of existing components. Install new components only when 

necessary. If you determine that a component that you have removed is not faulty, reinstall it.

Note: Replacement parts and specifications are subject to change. Install the correct parts as directed by your service/

support center.

The tools required to service the E-45A are listed on page 10.

Important: When performing the service procedures described in this chapter, follow the precautions listed on 

page 9.
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E-45A overview diagrams

Figure 19: Front and connector panel

A Front panel B Connector panel

1 Fiery QuickTouch LCD 6 Power connector 12 Type A USB3 ports (x2)

2 Type A USB 3.0 ports (x3)

Note: Do not use the USB ports on 

the Fiery QuickTouch for keyboard/

mouse connections for the service 

purpose.

7 Power switch
|: Power On
O: Power Off

13 Crossover Ethernet cable port 
(Lower RJ-45)

8 Type A USB 2.0 ports (x2) 14 Printer interface board

3 Fiery QuickTouch reset button 9 Network port (Upper RJ-45) 15 Type B USB port for power 
synchronization

4 Power button 10 Display port (for optional 
monitor)

16 OFF/ON switch for power 
synchronization
ON: Right
OFF: Left5 Front panel door 11 DVI port to the printer touch 

panel (for optional monitor)

17 (Optional) Printer interface 
board 

1 4

2 6

7

11

12 13

A B

3

5

14

15 16

17

8 9

10
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Figure 20: Inside the front door

1 DVD drive (inside behind door)

2 Eject button (inside behind door)

1

2



48Installation and Service Guide: Color Controller E-45A

Replacing parts

Figure 21: Exploded view of components

1 Top panel 7 Fan 13 CPU cooling assembly 17 Fiery QuickTouch USB3.0 
cable

2 Fiery QuickTouch display 8 Hard disk drive 14 Printer interface board

3 DVD drive 9 Motherboard 15 DVD drive data cable 18 Fiery QuickTouch power 
cable

4 Front panel 10 Battery 16 Hard disk drive data 
cables

5 Power supply 11 CPU 19 10-pin power button 
cable

6 Chassis 12 DIMMs

Note: CPU fan cable, tie-wraps, cable clamps, dongle(s), and external cables are not shown.

11

7

14

16

15

4

13

6 

2

3

5

8

10

1

12

9

17

18

19
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Figure 22: Power and data cable connections

Cable key From To (on motherboard connector)

1 Power supply cable Power supply a.  24-pin power connector (J18)

b. 8-pin power connector (PWRCONN1)

c. DVD drive power connector (combined with 
data)

d. Hard disk drive power connector

e. Fiery QuickTouch power connector

2 Fiery QuickTouch USB cable Fiery QuickTouch Motherboard connectors J26 (USB3.0 Header)

3 SATA Data cable DVD drive Motherboard SATA connector (SATA0)

4 SATA Data cable Hard disk drive Motherboard SATA connector (SATA1)

5 Rear fan cable Rear fan Motherboard connector J20 (FRONT FAN)

6 CPU fan cable CPU fan Motherboard connector J16 (If present, keep the 
cable cover on the CPU fan cable.)

1b

1c

7

1a

1d

3

2

4

5

6

1e

8

9
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Accessing internal components

Shut down and open the E-45A when you need to inspect or service internal components.

Shutting down the system

You can shut down the E-45A from the E-45A Fiery QuickTouch. When shutting down the E-45A, do the following:

You can shut down the E-45A from the Fiery QuickTouch or the printer touch panel.

Note: If the power synchronization is set to ON, you can shut down the E-45A by turning off the printer using the main 

power switch.

When shutting down the E-45A, do the following:

• Remove the power cable from the connector panel before removing or connecting interface cables or accessing the 

internal components. 

• If you are cycling power, wait at least 10 seconds before powering back on.

• If you are unable to shut down the E-45A through the Fiery QuickTouch, power off by holding down the power button 

on the side of the E-45A for up to eight seconds. 

For more information on how to shut down the E-45A, see page 41.

Opening the E-45A

To service internal components, open the E-45A as described in the following procedure.

To open the E-45A

1 Shut down the E-45A (see page 50).

2 Remove all cables from the back of the E-45A.

3 Remove the E-45A from the furniture.

7 Power switch cables Fiery QuickTouch J102 connector (pin 5, 6) on the printer interface 
board

Align triangle on 
cable connector as 
shown.

8 LED cable Fiery QuickTouch J102 connector (pin 7, 8) on the printer interface 
board

9 10-pin power button cable J103 connector on 
the printer interface 
board

Motherboard FP Header connector (J15)

Note: See the connection label attached inside the chassis.

Important: Remember that when the E-45A is powered off, network access to the printer is interrupted. Always 

obtain permission from the network administrator before you take the E-45A off the network.

LED +LED -

SW 
（Red/W
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4 Remove all external panels necessary to access the component that you need to service.

At the minimum, you must remove the left panel to service the component. You may also need to remove other panels, 

depending on the component that you need to access. For guidelines on which panels to remove, see the service 

procedures that accompany a given component.

Note: When removing multiple panels from the E-45A, use the following order:

• Left side panel

• Right side panel

• Front panel

• Top panel with Fiery QuickTouch

5 Place the E-45A on a flat surface. Carefully position the E-45A so that it is standing in its normal position. 

To remove the side panels

1 Remove the two screws at the bottom rear right of the chassis.

Figure 23: Removing the left panel

2 From the back of the unit, slide the right side chassis cover toward the rear of the unit and remove.
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3 Remove the two screws at the bottom rear left of the chassis.

Figure 24: Removing the right panel

4 From the back of the unit, slide the left side chassis cover toward the rear of the unit and remove.

To remove the front panel

1 Remove the anchor screw from the front bezel.

Figure 25: Front bezel anchor screw

2 Release the six tabs and pull the front bezel off.
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Figure 26: Front bezel tabs

To replace the chassis panels

1 Attach the front bezel to the front of the unit snapping tight the six tabs. See Figure 26. 

2 Insert the anchor screw to secure the front bezel. See Figure 25. 

3 Slide the right chassis cover into place and secure with two screws on backside of the unit.

4 Slide the left chassis cover into place and secure with two screws on backside of the unit.

1 Top tab (one on each side of bezel)

2 Middle tab (one on each side of bezel)

3 Bottom tab (one on each side of bezel)

1

2

3
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Fiery QuickTouch display module

Fiery QuickTouch is attached to the top panel of the E-45A.

Follow the directions to remove the chassis covers. See “Opening the E-45A” on page 50. You will need to remove the side 

covers, then the front cover before you will be able to release the top bezel with the Fiery QuickTouch attached. 

To remove the Fiery QuickTouch

1 Follow the instructions to remove the side and front chassis covers.

2 To remove the top bezel, slide the bezel forward and release it from the top of the chassis.

3 Stabilize the unit and set the Fiery QuickTouch on its side atop the unit.

4 Remove the two connectors to the Fiery QuickTouch.

a Remove the tie-wrap that bundles the power cable and a tab on the support bracket for USB connector. 

Caution:  It is highly recommended that you use a screwdriver with a magnetic tip when removing or replacing 

screws on the Fiery QuickTouch. If you do not, the screws you remove or replace might fall inside the Fiery 

QuickTouch device. 
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b Remove the power harness by unplugging it.

c Remove the two screws from the USB connector and then unplug the connector.

5 Turn the unit so it is faced down on the work surface.

Caution: Use a screwdriver with a magnetic tip so you do not drop a loose screw into the Fiery QuickTouch unit. 

1 Power harness connector

2 USB connector 

1

2
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6 Remove the single screw in the center, then remove the washer and spring washer.

7 Rotate the Fiery QuickTouch 45 degrees.

8 Remove the top bezel.

Replace the Fiery QuickTouch

1 Attach the new Fiery QuickTouch part to the top bezel by rotating the top bezel 45 degrees, then rotate until the bezel 

and Fiery QuickTouch align.Insert the spring washer, then the screw with washer and tighten.

2 Once attached, ensure that the Fiery QuickTouch moves properly from side to side.

3 Place the top bezel with Fiery QuickTouch atop the unit on its side.

4 Plug in the USB cable and insert the plug so that the mark on the cable and mark on the internal board line up.

5 Insert the two screws to secure the plug and grounding bracket.

6 Insert the power harness and loop it around guides to allow the Fiery QuickTouch to move freely.

7 Use a tie-wrap to secure the power cable to the tab on the supporting bracket for USB connector. 

8 Replace the top bezel on top of the unit and slide back in place. 

Caution: Use a screwdriver with a magnetic tip so you do not drop a loose screw into the Fiery QuickTouch unit. 
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9 Check that the bezel cover extends over the rear sheet metal to be properly in place.

10 Replace the chassis panels (see page 53). 

Removing and replacing boards

This section includes procedures for removing and replacing the following boards:

• Printer interface board

• Motherboard

The E-45A is shipped from the factory with a standard board configuration. If optional components have been installed, 

see the documentation that accompanies the particular option kit.

Printer interface board

The printer interface board provides the print interface between the E-45A and the printer. It is installed in motherboard 

connector PCIE x16. The printer interface board processes the image data and sends it to the printer through the printer 

interface  cable available on the E-45A connector panel.
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The optional printer interface board for specialty color is installed in the motherboard connector PCIE x8. 

To remove the printer interface board

When you handle electronic components, follow electrostatic discharge precautions (see page 10).

1 Shut down and open the E-45A (see pages 50). 

To remove the printer interface board, you must remove the left panel.

2 Remove the board mounting bracket screw that attaches the printer interface board to the chassis.

3 Remove the printer interface board from the chassis.

Grasp the printer interface board at the front and back edges and gently pull the board straight out of its motherboard 

connector. 

4 Place the printer interface board in an antistatic bag.

1 J102 connector for LED/SW cables 
from the Fiery QuickTouch panel

2 J103 connector for 10-pin power 
button cable to motherboard J15 
connector

1 J102 connector for power/reset button 
cable from the front panel

2 J103 connector for 10-pin power 
button cable to motherboard J15 
connector

1

2

1

2
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To replace the printer interface board

When you handle electronic components, follow electrostatic discharge precautions (see page 10).

1 Seat the printer interface board in the motherboard connector, and then secure it to the chassis with the board mounting 

bracket screw that you removed earlier.

The printer interface board edge connector is keyed to fit in the motherboard connector only when properly oriented. 

Insert the standard printer interface board into the PCIE x16 slot (the top slot). Insert the optional printer interface 

board into the PCIE x8 slot. See the documentation that comes with the optional printer interface board kit. 

2 Connect the power/reset button cables from the front panel to the J102 connector.

3 Connect the power/LED cables from the front panel to the J102 connector.

4 Connect the power/reset button cables from the front panel to the J352 connector.

5 Connect the 10-pin power button cable from the FP HDR (J15) connector to the J103 connector (see Figure 22 on 

page 49).

6 Reassemble the E-45A and verify its functionality (see page 86).

Motherboard

The CPU mounted on the motherboard controls the image data transferred to and from the printer interface board. The 

motherboard also controls hard disk drive functions and the communication between the E-45A and external devices.

1 LED cable connection

2 SW cable connection

Important: If you are removing the motherboard in order to replace it with a new motherboard, review the 

troubleshooting and motherboard cautions on page 64.

LED +LED -

SW 
（Red/White）

1

2 Align triangle on cable connector as shown.
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Motherboard replacement overview

Removing the motherboard

The motherboard attaches to the side of the chassis, below the power supply. Before you remove the motherboard, you 

must remove the following:

• The left panel

• All boards installed on the motherboard

You suspect a faulty motherboard 

or hard disk drive.

Replace the hard disk drive.

Reinstall system software.

Problem solved?
Yes.

Reassemble system and verify functionality.

No.

Reinstall old hard disk drive.

Replace the motherboard.

Connect the 

motherboard replacement dongle.

Enter Service Mode and 

verify the new motherboard 

installation.

Reinstall the old motherboard.

Return the new motherboard and 

dongle to inventory.

Are test pages

printed successfully?

Transfer options and

BIOS information to the 

new motherboard.

Yes.

No.

See page 80

See page 98

See page 64

See page 67

See page 69

See page 80

Note: Each page 

reference includes more 

information for each 

task.
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• All cables connected to the motherboard

(including the motherboard power cable, CPU power cable, rear fan cable, hard disk drive data cable, DVD drive 

power and data combination cable, power/LED cable, 10-pin power button cable, and Fiery QuickTouch USB port 

cables)

This section also includes information about the following:

• Replacing or adding DIMMs 

• Replacing the CPU

• Replacing the battery

• Jumper configurations

Important: Follow standard ESD and other safety precautions when handling components (see page 10). During 

service to the motherboard, avoid using excessive force and always place the motherboard on a grounded, 

non-metallic, static-free surface. Never allow any metal to touch the solder contacts on the underside of the 

motherboard, especially beneath the battery socket. Improper handling can short-circuit and permanently damage the 

motherboard.
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Figure 27: Motherboard

To remove boards and cables from the motherboard

1 Shut down and open the E-45A (see pages 50). 

To access the motherboard, you must remove the left side panel. 

2 Remove the 10-pin power button cable that connects the printer interface board and the motherboard.

1 Type A USB ports and 
network port

8 Optional printer interface 
board (PCIE_X8_SLOT)

15 Fiery QuickTouch USB 
ports (J26)

2 Monitor port (DisplayPort) 9 Battery (XBT1) 16 Power switch and LED 
(J15)

3 Monitor port (DVI) 10 DIMM0 (A1) 17 SATA0, DVD drive data 
connection

4 Crossover Ethernet port/
Type A USB ports (x2)

11 DIMM1 (B1) 18 SATA1, Hard disk drive 
data connection

5 8-pin power connector 
(PWRCONN1)

12 CPU fan power (CPU FAN) 19 Clear CMOS Jumper (J4)

6 CPU cooling assembly 13 Rear fan (FRONT FAN) MH Mounting holes

7 Printer interface board 
(PCIE_X16_SLOT)

14 24-pin power connector 
(J18)

Note: Arrows indicate positions for inserting cable and jumper connections.

1

4

9

2

7

3

5

11

6

MH

MH

MH

MH MH

MH MH

MH

12

14

15

16

17

18
19

13

MH

10

8
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3 Remove all boards installed in slots on the motherboard.

Note the location of the slot where each board resides so that you can reinstall the board in the same slot later.

4 Remove the following cables from the old motherboard:

Note: First remove any plastic cable clamp(s) securing internal cables and tie-wraps.

• Rear fan cable

• Fiery QuickTouch power/LED cable

• Fiery QuickTouch USB port cable

• DVD drive cables:

• SATA data cable

• Power and data combination cable

• Hard disk drive cables:

• SATA data cable

• Power supply cable

• 24-pin motherboard power cable

• 8-pin motherboard power cable

• CPU fan cable

• In-line spectrophotometer cable

For motherboard connector locations, see page 60.

To remove the motherboard

Note: This procedure assumes that you have already performed the procedure “To remove boards and cables from the 

motherboard” on page 62.

1 Remove all the mounting screws securing the motherboard to the chassis (for screw locations, see page 62).

2 Remove the motherboard from the chassis. 

Lift the edge of the motherboard. Make sure that the motherboard connectors clear the chassis while you lift it out of 

the chassis. Do not touch the contacts and avoid using excessive force.

Important: During service, avoid using excessive force and always place the motherboard on a grounded, 

non-metallic, static-free surface. Never allow any metal to touch the solder contacts on the underside of the 

motherboard, especially beneath the battery socket. Improper handling can short-circuit and permanently damage the 

motherboard. 
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Replacing the motherboard

Troubleshooting cautions

• Before deciding to install a new motherboard, consult “Troubleshooting” on page 105.

• Inspect all cables and internal components as described on pages “Checking external connections” on page 105 and 

“Checking internal components” on page 106.

• If troubleshooting strategies (checking cables and connections, reinstalling system software, and so forth) do not solve 

the problem, and you suspect that the hard disk drive or the motherboard is faulty, always troubleshoot in the following 

order. 

• First, replace the hard disk drive and install system software. 

Always replace a faulty hard disk drive with a new hard disk drive. Transferring a hard disk drive from one E-45A to 

another is incorrect and strongly discouraged.

• If the problem persists, reinstall the original hard disk drive in the system, and then replace the motherboard.

Motherboard cautions

• Do not transfer the BIOS chip from the old motherboard onto the new motherboard. 

BIOS chips are not interchangeable. 

• Do not reinstall system software at this time.

Reinstalling system software is not necessary when installing a new motherboard and can result in an error if done 

before transferring options to the new motherboard (described on page 68.)

Important: Follow the procedures in this section to replace the motherboard. Failure to follow the instructions in this 

section may corrupt the system (not easily repaired in the field) or result in an incomplete installation.

Important: Troubleshooting in the wrong order will cause the system to malfunction. In general, it is highly 

unlikely that both the hard disk drive and the motherboard are defective; therefore, avoid replacing both to solve 

one problem.

Important: If you have exhausted all other troubleshooting remedies and determined that you need to install a new 

motherboard, be sure to observe the following cautions:
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• Before you use the motherboard replacement dongle to sync the BIOS and options (for example, Fiery Graphic 

Arts, Premium Edition, if applicable) from the hard disk drive to the new motherboard, enter Service Mode (see 

page 68) and make sure that the new motherboard solves the problem that you are troubleshooting. 

The E-45A can remain in Service Mode indefinitely. Use Service Mode to carefully verify the new motherboard before 

transferring options to the new motherboard. 

Transferring options to the new motherboard permanently customizes the new motherboard. Once customized, the 

motherboard cannot be returned to inventory or installed in another E-45A. If the new motherboard does not solve the 

problem in Service Mode, do not transfer options. Return the new motherboard and motherboard replacement dongle to 

inventory. 

• If you can verify in Service Mode that the new motherboard solves the problem that you are troubleshooting, 

transfer options to the new motherboard using the motherboard replacement dongle included with the new 

motherboard (see page 68).

• Do not remove the motherboard replacement dongle while transferring options to the new motherboard.

Removing the motherboard replacement dongle prematurely will corrupt the dongle and possibly damage the 

motherboard. If either become corrupted, you must contact your authorized service/support center and order a new 

replacement motherboard kit. 

To replace the motherboard

1 If you are installing a new motherboard, do the following: 

• Unpack the new motherboard.

• Open the load plate covering the CPU socket (see page 72) and remove the protective plastic cover on the CPU 

socket on the new motherboard. Later, you will transfer the protective plastic cover to the CPU socket of the old 

motherboard to protect the circuitry.

• Remove the DIMMs from the old motherboard and install them on the new motherboard (see page 70).

• Remove the CPU and cooling assembly from the old motherboard and install them on the new motherboard (see 

page 70). Make sure that the cable cover (if present) remains on the cooling assembly fan cable when transferring 

the cooling assembly to the new motherboard. 

Important: When transferring the CPU to the new motherboard, make sure to use the fresh thermal compound 

that came with the new motherboard. For more information about the thermal compound, see page 73.

Important: Do not transfer the BIOS chip from the old motherboard onto the new motherboard. Doing so can 

damage the E-45A. BIOS chips are not interchangeable.
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2 Install the motherboard in the chassis.

Angle the motherboard so that the motherboard connectors fit into the cutouts in the back of the chassis. 

3 Align the mounting holes on the motherboard with the standoffs located in the base of the chassis.

4 Secure the motherboard to the chassis using all the mounting screws that you removed earlier.

Partially tighten each screw before completing tightening any one screw. Do not overtighten the screws; doing so could 

damage traces on the motherboard.

You are now ready to complete motherboard installation.

To replace boards, cables, and components

1 Replace the hard disk drive bracket, with hard disk drive attached (see page 83).

You removed the hard disk drive bracket to provide clearance for removing the motherboard.

2 Replace the following cables (see page 62 for the connector locations).

• CPU fan cable

• 24-pin motherboard power cable

• 8-pin motherboard power cable

• Fiery QuickTouch power/LED cable

• Hard disk drive cable

• DVD drive cables:

• Power and data combination cable

• SATA data cable

• Fiery QuickTouch USB port cables

• Rear fan cable

• In-line spectrophotometer

3 Secure cables as necessary with any plastic cable clamp that you may have removed earlier.

Important: Make sure that the flexible grounding tabs on the cutouts for the network ports make contact with the 

outside of the ports. Do not allow the tabs to fold over or become bent inside the ports. The ports will not function 

if the tabs are placed improperly. Take care when lowering the new motherboard into the chassis. Do not strike the 

motherboard against the metal standoffs attached to the chassis, as doing so can damage the components on the 

underside of the motherboard.



67Installation and Service Guide: Color Controller E-45A

Replacing parts

4 Replace the printer interface board (see page 62 for the location).

Make sure to install the board mounting bracket screw to secure the board to the chassis. Press down firmly on the top 

of the board as you insert the screw. 

5 Replace the 10-pin power button cable that connects the printer interface board (J102 connector) and the motherboard 

connector (J15).

6 If you reinstalled the old motherboard, reassemble the E-45A and verify its functionality (see page 85).

7 If you replaced the motherboard with a new motherboard, do the following:

• Remove the battery (see page 74).

• Wait two minutes to allow the motherboard electrical components to fully discharge.

• Reinstall the battery.

• Reassemble the E-45A (see page 85).

• Reset the time and date in Setup (see Command WorkStation Help for more information).

Verifying new motherboard installation, and transferring options and BIOS information

After you install a new motherboard and reassemble the system, do the following:

• Verify all functionality by using the motherboard replacement dongle to enter Service Mode. (Service Mode is not 

indicated on the monitor or Fiery QuickTouch panel, but is entered once you power on with a new motherboard 

installed and the motherboard replacement dongle installed on a USB port.)

Service Mode is a temporary state that allows you to make sure that the motherboard solves the problem that you are 

troubleshooting. Service Mode is exited automatically when you expend the motherboard replacement dongle to 

transfer options to the new motherboard (see “Entering Service Mode” on page 68).

Note: Features of Fiery Impose-Compose are not available while in Service Mode.

Important: Make sure that unused connector panel slots are covered with slot covers. Uncovered slots reduce air 

flow and may cause the E-45A to overheat.
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• If the new motherboard solves the problem that you are troubleshooting, use the motherboard replacement dongle to 

transfer options to the new motherboard.

If you determine while in Service Mode that the problem you are troubleshooting was not fixed by installing a new 

motherboard, do not expend the motherboard replacement dongle to transfer options to the new motherboard 

(described below), do not install system software, and do not replace the hard disk drive. Reinstall the old motherboard 

and return the new motherboard and the unused motherboard replacement dongle to inventory. You may then perform 

additional service and troubleshooting procedures.

Transferring options (for example, Fiery Graphic Arts, Premium Edition, if applicable) expends the motherboard 

replacement dongle. For details, see “Entering Service Mode” on page 68. 

Entering Service Mode

Use the following procedure to verify that the system functions properly after installing a new motherboard.

To enter Service Mode and verify the system

Note: This procedure assumes that the E-45A is powered off, no media is in the DVD drive, you have installed a new 

motherboard, and that you have reassembled the E-45A and attached external cables.

1 Make sure the E-45A is connected to the printer (see page 21).

2 Locate the motherboard replacement dongle provided with the new motherboard and connect it to a USB port.

3 Remove all USB devices (except for the keyboard and mouse) that may be currently connected to any other USB port. 

Reconnect other dongles and USB devices only after you verify that the E-45A starts up successfully in Service Mode. 

4 Power on the E-45A and allow it to boot without interruption.

At the log on screen, log in as Admin, type Fiery.1 in the password field, and then press Enter on the keyboard. Type 

Fiery.1 exactly as shown. The password is case-sensitive; for example, fiery.1 will not work.

At this point the E-45A is in Service Mode, so you can verify that the new motherboard solves the problem that you are 

trying to troubleshoot. Service Mode is not indicated on the monitor or on the E-45A Fiery QuickTouch.

5 Print the E-45A Test Page. 

6 Ask the network administrator to connect the E-45A to the network and download a print job over the network (see 

Configuration and Setup, which is part of the user documentation set).

If the problem that you are troubleshooting persists, or if you are unable to perform steps 4 through step 6 above while in 

Service Mode, you may conclude that the old motherboard was not the source of the problem and does not need to be 

replaced. If so, do not transfer options to the new motherboard (described on page 68), do not install system software, and 

do not replace the hard disk drive. Reinstall the old motherboard and return the new motherboard with the unexpended 

motherboard replacement dongle to inventory. For more information about troubleshooting system problems, see 

“Troubleshooting” on page 105.

Important: Do not transfer options to the new motherboard prematurely. Do so only after you verify the new 

motherboard in Service Mode. Remember that once options are transferred to the new motherboard using the 

motherboard replacement dongle, the motherboard is customized and cannot be used in another system.
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If installing a new motherboard solved the problem that you are troubleshooting and you are able to print a Test Page and 

send a print job over the network, you are ready to transfer options to the new motherboard. Service Mode ends 

automatically when you transfer options to the new motherboard.

Transferring options and BIOS information to the new motherboard

After you verify that the new motherboard solves the problem that you are troubleshooting, you must use the motherboard 

replacement dongle to transfer options to the new motherboard.

To transfer options and BIOS information to the new motherboard

Note: This procedure, which takes approximately 15-20 minutes, assumes that the E-45A is fully assembled with the new 

motherboard, and verified in Service Mode (see page 68).

1 Verify that all power is turned off on the E-45A.

2 Insert the motherboard replacement dongle into a USB port.

3 Turn on the E-45A.

Wait until the E-45A reaches Idle.

4 On the E-45A Fiery QuickTouch, select MB Replacement.

The Fiery QuickTouch displays “Reading dongle...”, then displays the number of licenses left to apply to the transfer.

5 Select Yes to confirm the license transfer.

The Fiery QuickTouch displays “Applying” to indicate the transfer of options and the backup BIOS from the hard disk 

drive to the BIOS chip on the replacement motherboard.

Note: If you select “No” the process ends and you return to the Functions menu.

6 Reboot the E-45A.

7 Remove the motherboard replacement dongle after the E-45A reaches Idle.
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Replacing parts on the motherboard

Before you remove and replace the DIMMs, CPU, and battery on the motherboard, shut down and open the E-45A (see 

page 50).

DIMMs

When installing DIMMs, note the following:

• Different capacity DIMMs look alike. Make sure that you know the capacity of each DIMM before you install it in a 

socket.

• Install only approved DIMMs available from your service representative.

• DIMMs must be installed in matched pairs. A matched pair is comprised of two alternate sockets. DIMMs within a pair 

must be identical (same capacity and same number of chips on each side). For example, in a two-DIMM configuration, 

populate DIMM 1 and DIMM 2 with DIMMs of identical capacity, with the same number of chips on each side.

To replace a DIMM

1 Shut down, and then open the E-45A (see page 50). 

To access the DIMMs, you must remove the left panel.

2 Remove the printer interface board from the motherboard (see page 58). 

3 To release a DIMM, push outward on the levers on each side of the DIMM.

4 Pull the DIMM straight out of the socket. 

5 To replace a DIMM, insert the DIMM straight into the socket and close the levers at each side to lock it into place. 

Note: The socket is keyed so that the DIMM fits only one way. (See the notches in the preceding figure.)

6 If you installed a new DIMM, make sure to reset the time and date in Setup (see Configure Help for more information).

7 Replace the printer interface board (see page 59). 

8 Reassemble the E-45A and verify its functionality (see page 86).

CPU

The CPU is installed in a socket on the motherboard. Before you remove the CPU from its socket, remove the motherboard 

from the chassis (see page 60), disconnect the CPU fan cable from the motherboard, and then remove the cooling assembly 

from the E-45A (see page 71). The CPU cooling assembly consists of a fan and a heatsink.

Note: Do not remove the CPU fan from the heatsink.

Important: Make sure that the entire length of the DIMM (ends and center) is fully seated in the socket and that 

the levers close securely around the ends of the DIMM. 
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Figure 28: CPU cooling assembly

To remove the cooling assembly

1 Shut down, and then open the E-45A (see pages 50). 

To access the CPU, you must remove the left panel.

1 CPU fan 5 Yellow triangle

2 Fastener screw (1 of 4) 6 Load plate open

3 Heatsink 7 Yellow triangle

4 CPU

Important: If you remove the CPU from the motherboard in order to install it on a new motherboard, unpack the 

new motherboard and remove the protective plastic cover on the CPU socket. Transfer the protective cover to the 

CPU socket of the old motherboard to protect the circuitry. Follow standard ESD precautions while handling the 

motherboard and all components.

1

2

3

4

5

6

7
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2 Remove the CPU fan cable from motherboard connector CPU FAN.

3 Remove the CPU cooling assembly.

• Loosen the four screws that secure the cooling assembly to the motherboard. Partially loosen all the screws before 

loosening any one screw all the way.

• Lift the cooling assembly off the CPU socket and set it aside.

4 Lift the cooling assembly off the CPU socket and set it aside.

To remove and replace the CPU

1 Unlock the CPU socket lever and raise it into the open position (flex the lever away from the retention post, and then 

raise it). 

2 Open the load plate.

3 Grasp the CPU by its edges, lift it out of the socket, and then place the CPU in a safe place.

Note: If you remove the CPU from the motherboard to install it on a new motherboard, unpack the new motherboard 

and remove the protective plastic cover from the CPU socket. Transfer the protective cover to the CPU socket of the old 

motherboard to protect the circuitry. 

4 Wipe the contact surface of the CPU (the smooth, gray side of the chip) with a clean, lint-free cloth to ensure proper 

contact with the new heatsink.

If you remove the CPU from the motherboard to install it on a new motherboard, make sure that you completely 

remove any thermal compound residue on the surface of the CPU and at the base of the heatsink. It may help to scrape 

all the residue off of the surface using the flat edge of something non-conductive. 

Caution: Be aware that both the cooling assembly and the CPU may be very hot. You may need to allow the 

components to cool before you attempt to remove them.

1 Screw (1 of 4)

2 Loosen each screw to this position.

1

2
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5 Prepare the CPU socket by ensuring that:

• The socket lever is in the open position. 

• The load plate is open.

6 Place the CPU in the socket.

The CPU and the socket are keyed to ensure correct installation. The notches on the edges of the CPU correspond with 

the two small posts inside the socket. Align the yellow triangle on the CPU with the yellow triangle on the socket. Do 

not force the CPU.

7 Close the load plate.

8 Lower the socket lever and place it in the locked position under the retention post.

Figure 29: Removing/replacing the CPU

To replace the CPU cooling assembly

Note: Before you install the cooling assembly, completely remove any thermal compound residue on the surface of the 

CPU and the base of the heatsink, and then apply a fresh thermal compound square to the base of the heatsink. When 

installing the thermal compound square, make sure to remove the plastic backing on both sides of the square. Avoid 

creating any bubbles or wrinkles on the square. Bubbles and wrinkles reduce the heat-transfer efficiency of the cooling 

assembly.

1 Prepare the CPU cooling assembly for installation.

• Make sure that the motherboard is placed on a padded, static-free work surface.

• Apply a fresh thermal compound square, as described in the note above.

• Align the cooling assembly so that when it is installed, the fan cable easily reaches the CPU fan power connector 

CPU FAN on the motherboard.

1 Socket lever in the locked position 4 CPU

2 Load plate open 5 Yellow triangle

3 Yellow triangle 6 Socket lever in the open position

1

2

3

4

5

6
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2 Place the cooling assembly on the CPU.

• Make sure that the thermal pad on the underside of the heatsink is positioned on top of the CPU.

Be sure to remove any protective material that may be covering the surface of the thermal pad. Otherwise the CPU 

may overheat.

• Align the four screws with the four screw posts.

Tighten the screws. Partially tighten all the screws before tightening any one screw all the way.

3 Connect the CPU fan cable to the motherboard connector CPU FAN. 

4 If you installed a new CPU, make sure to reset the time and date in Setup (see Configure Help for more information).

5 Reassemble the E-45A and verify its functionality (see page 86).

Battery

The battery on the motherboard is located at XBT1. To replace it, use a 3V manganese dioxide lithium coin cell battery 

(Sony CR2032 or equivalent).

ACHTUNG: Es besteht Explosionsgefahr, wenn die Batterie durch eine Batterie falschen Typs ersetzt wird. Als Ersatz 

dürfen nur vom Hersteller empfohlene Batterien gleichen oder ähnlichen Typs verwendet werden. Verbrauchte Batterien 

müssen entsprechend den jeweiligen gesetzlichen Bestimmungen entsorgt werden.

ATTENTION : Il y a risque d’explosion si la pile est remplacée par un modèle qui ne convient pas. Remplacez-la 

uniquement par le modèle recommandé par le constructeur. Débarrassez-vous des piles usées conformément aux 

réglementations locales en vigueur.

ADVARSEL!: Litiumbatteri - Eksplosionsfare ved fejlagtig håndtering. Batteriet må kun udskiftes med et andet batteri af 

samme fabrikat og type. Brugte batterier skal bortskaffes i henhold til gældende regler.

VAROITUS: Paristo voi räjähtää, jos se on vaihdetaan väärän tyyppiseen paristoon. Vaihda paristo ainoastaan 

laitevalmistajan suosittelemaan tyyppiin. Hävitä käytetty paristo paikallisten määräysten mukaisesti.

ADVARSEL: Eksplosjonsfare ved feilaktig skifte av batteri. Benytt samme batteritype eller en tilsvarende type anbefalt av 

apparatfabrikanten. Brukte batterier kasseres i henhold til lokal lovgivning.

VARNING: Risk för explosion om batteriet byts ut mot en felaktig batterityp! Byt bara ut batteriet mot en batterityp som 

har godkänts av tillverkaren. Hantera använda batterier enligt lokal miljölagstiftning.

CUIDADO: Existe peligro de explosión si la batería se sustituye por una batería del tipo incorrecto. Sustituya la batería sólo 

por una batería del mismo tipo que recomienda el fabricante. Deseche las baterías usadas respetando la normativa local.

Important: If you are installing a new CPU, secure slack in the fan cable using a tie-wrap. The tie-wrap prevents 

the fan cable from interfering with the CPU fan. Also, make sure the connector on the cable is securely connected 

to the motherboard.

Warning: There is danger of explosion if the battery is replaced with an incorrect type. Replace it only with the same 

type recommended by the manufacturer. Dispose of used batteries according to local regulations.
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ATTENZIONE: Esiste pericolo di esplosione se la batteria viene sostituita con una di tipo non corretto. Sostituirla solamente 

con un tipo raccomandato dal produttore. Lo smaltimento delle batterie usate deve essere eseguito secondo le normative 

locali.

AVISO: Existe o perigo de explosão se a bateria for substituída por uma do tipo incorreto. Substitua somente por uma do 

tipo recomendado pelo fabricante. Descarte as baterias conforme as normas locais.

GEVAAR: Er bestaat ontploffingsgevaar indien de batterij door een verkeerd type wordt vervangen. Vervang de batterij 

uitsluitend door hetzelfde door de fabrikant aanbevolen type. Ruim gebruikte batterijen op volgens de plaatselijke 

voorschriften.

To replace the battery

1 Shut down, and then open the E-45A (see pages 50 and 50). 

2 Locate the battery on the motherboard (see Figure 27 on page 62).

3 Carefully push the clip away from the battery until the socket ejects the battery.

Figure 30: Motherboard battery

4 Slide the battery out of its socket.

5 Wait two minutes to allow the motherboard electrical components to fully discharge.

6 To insert a new battery, slide it into the socket so that the positive (+) side of the battery faces up. 

7 Press the battery down into the socket until it snaps into place.

Make sure that the battery is securely installed in the socket.

8 Reassemble the system and verify its functionality (see page 85).

9 Configure the time and date in Setup (see Configure Help for more information). 

1 Clip

2 Battery

3 Socket

Important: Failure to configure the time and date will cause the E-45A to hang when user software is being 

installed on the E-45A.

1

2

3
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Jumpers

Jumper configurations should not be changed.

Fan

A fan mounted inside the E-45A chassis draws air into the E-45A to cool components. The fan runs continuously when the 

system is on. You should hear the fan start as soon as you power on the E-45A. If you do not hear the fan, there may be a 

faulty power connection.

The following procedures describe how to remove and replace the fan.

To remove the fan

1 Shut down, and then open the E-45A (see pages 50 and 50). 

To access the fan, you must remove the left panel.

2 Remove the fan cable from motherboard connector FRONT FAN.

Jumper Description

J101 J4 is the Clear CMOS and Password jumper. Default configuration: jumper cap installed on pins 2 and 3.

Note: It is not necessary to clear the CMOS settings when servicing motherboard components, the DVD 
drive, and the hard disk drive.

Pin 1
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3 Remove the four screws from the connector panel, while holding the fan assembly from the inside. 

Set aside the screws. 

Figure 31: Removing/replacing the fan

4 Remove the fan from the chassis.

To replace the fan

1 Align the fan with the four holes on the connector panel. 

2 Install the four screws you removed earlier to secure the fan assembly to the connector panel. 

3 Connect the fan cable to motherboard connector FRONT FAN. 

4 Reassemble the E-45A and verify its functionality (see page 86).

1 Fan assembly 3 Screw (1/4)

2 Airflow direction 

1

3

2
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Power supply

This section describes how to remove and replace the power supply. For more information about the power supply, see 

“Physical specifications” on page 121.

To remove the power supply

1 Shut down the E-45A, remove all cables from the back, and then open the system (see page 50).

To remove the power supply, you must remove the left and right panels.

2 Remove the 24-pin power cable from connector J18 on the motherboard.

3 Remove the 8-pin power cable from connector PWRCONN1 on the motherboard.

4 Remove the SATA power cables from the hard disk drives.

5 Detach the SATA power cable from the power connector of the dual cable for the DVD drive. 

6 Detach the 8-pin power cable from the connector from the Fiery QuickTouch.

7 Remove any tie-wraps securing the power cables to the chassis.

8 Place the E-45A in the upright position.

9 Remove the motherboard from the chassis (see page 63).

10 Remove the four connector panel screws that secure the power supply to the back of the chassis (see Figure 32).

11 While squeezing the power supply unit, remove the inside screw with washer. 

Caution: Do not open the power supply for service or troubleshooting purposes. Opening the power supply will void 

the warranty.
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12 Slide the power supply toward the front panel and take the power supply off from under the chassis bar.

Figure 32: Removing/replacing the power supply

To replace the power supply

1 Make sure that the E-45A is in upright position.

2 Position the power supply inside the chassis (see Figure 32 on page 79).

Insert the power supply unit under the chassis bar, and place the power supply on top of the left and right chassis bars. 

Position the power supply so that it is flush against the connector panel. 

3 Install the inside screw with washer to secure the power supply unit to the chassis top. 

1 Power supply unit

2 Chassis bar

3 Screw (1 of 4)

4 Inside screw

Note: To service the power supply, place the E-45A in an upright position.

1

3

2

4
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4 Install the four screws that secure the power supply to the connector panel of the chassis.

5 Replace the motherboard (see page 65). 

6 Connect one of the SATA power cables to the power connector on the dual data/power cable that connects to the DVD 

drive. 

7 Connect three of the other SATA power cables to the SATA power connectors on the hard disk drive.

8 Connect the power cables to the motherboard (see Figure 22 on page 49 and Figure 27 on page 62):

• 8-pin power cable to connector PWRCONN1

• 24-pin power cable to connector J18

9 Replace the tie-wraps that you removed earlier.

10 Reassemble the E-45A and verify its functionality (see page 85).

Hard disk drive

The factory-installed hard disk drive is formatted and loaded with system software, network drivers, and printer fonts. The 

hard disk drive is also used to store spooled print jobs. Available space on the hard disk drive is displayed in 

Command WorkStation.

If you replace the hard disk drive with a new one, you must restore the backup (see page 87) or install system software as 

described on page 98. (Spare hard disk drives are not shipped with preinstalled system software.) 

It is unlikely that both the hard disk drive and the motherboard are defective. Avoid replacing both to solve one problem. If 

troubleshooting strategies (such as checking cables and connections; see page 105) do not solve the problem, and you 

suspect either the hard disk drive or the motherboard is at fault, use the following order to troubleshoot: replace the hard 

disk drive, install system software, and then check to see if the problem persists. If it does, perform other procedures, such 

as replacing the motherboard (see page 64). 

Proper handling

• Use proper ESD practices when grounding yourself and the E-45A.

• Keep magnets and magnetic-sensitive objects away from the hard disk drive. 

• Do not remove the screws on top of the hard disk drive. Loosening these screws voids the warranty. 

• Never drop, jar, bump, or put excessive pressure on the hard disk drive.

• Handle the hard disk drive by its sides and avoid touching the printed circuit board.

• Allow the hard disk drive to reach room temperature before installation.

Important: Do not replace the hard disk drive and the motherboard at the same time. Doing so in the wrong order, 

without updating the system (see page 64), will cause the system to malfunction. 

Important: Improper handling can damage a hard disk drive. Handle the hard disk drive with extreme care.
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Hard disk drive problems may be caused by the following:

• Loose or faulty connections

• Faulty data or power cable

• Faulty hard disk drive

The hard disk drive is mounted inside a bracket (see Figure 34 on page 83).

If you are replacing the hard disk drive with a new one, you will need:

• The appropriate system software and documentation for the E-45A that you are servicing.

• A compatible version of the user software for the networked computers that will print to the E-45A.

To remove the hard disk drive

1 If you are removing the hard disk drive in order to install a new drive, give the site administrator the opportunity to 

print the Job Log and save any custom simulations. If possible, create a system backup (page 87), and print the 

Configuration page and Font List.

2 Shut down and open the E-45A (see pages 50). 

To access the hard disk drive, you must remove the left panel.

3 Remove the power supply cable from the hard disk drive.

4 Remove the hard disk drive data cable from the hard disk drive.

5 Remove the screw securing the hard disk drive bracket to the bracket shelf.

6 Slide the hard disk drive bracket off the shelf and lift it out of the chassis.

Unlock the hard disk drive bracket by moving the latch toward the connector panel, and then sliding the bracket off the 

bracket shelf. 

Note: You will encounter slight resistance as you slide the bracket off the shelf. The resistance is caused by two tension 

points on the bottom of the bracket. The resistance helps control the bracket’s movement during removal and 

installation.

Important: Make sure that you attach an ESD grounding wrist strap and follow standard ESD precautions before 

handling E-45A components. 

Important: Avoid striking the DIMMs as you remove the hard disk drive bracket.
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Figure 33: Removing/replacing the hard disk drive bracket

1 Tension points 4 Shelf

2 Latch 5 Screw

3 Hard disk drive bracket

Note: Printer interface board and internal cables are not shown.
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7 Remove the four screws that attach the hard disk drive to the hard disk drive bracket (see below).

Figure 34: Removing/replacing the hard disk drive from/in the hard disk drive bracket

8 Remove the hard disk drive from the hard disk drive bracket and place it in an antistatic bag. 

Do not touch the drive with magnetic objects (such as magnetic screwdrivers), and avoid placing magnetic-sensitive 

objects (such as credit cards and employee ID cards) near the hard disk drive.

Replacement hard disk drives are not shipped with preinstalled system software. After you install the drive, you must 

install the appropriate system software.

To replace the hard disk drive

1 If you are installing a new hard disk drive, unpack the drive. 

Do not drop, jar, or bump the hard disk drive. Do not touch the hard disk drive with magnetic objects or place magnetic-

sensitive objects near the hard disk drive.

1 2.5 inch HDD

2 Mounting bracket for 2.5 inch HDD

3 Screw with washer (1/4) 

4 HDD sled

5 Screw (1/4)

Important: Do not unscrew the screws on the hard disk drive cover. Loosening these hard disk drive screws 

breaks the seal and voids the hard disk drive warranty. 

Important: Do not install a new hard disk drive and a new motherboard at the same time. If you suspect that the E-

45A needs a new hard disk drive and a new motherboard, first install the new hard disk drive and install system 

software, then install a new motherboard and transfer options (see pages 64 and 68).

1

2

4

5

3
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2 Position the hard disk drive inside the hard disk drive bracket and align the front-most mounting holes on the hard disk 

drive with the four holes in the bracket.

When correctly installed, the hard disk drive extends about an inch past the rear of the bracket.

3 Replace the four screws that you removed earlier to attach the hard disk drive to the bracket. 

4 Slide the bracket all the way onto the shelf and lock it by moving the latch toward the front panel. 

Note: You will encounter slight resistance as you slide the bracket onto the shelf. The resistance is caused by two 

tension points on the bottom of the bracket. The resistance helps control the bracket’s movement during removal and 

installation. 

5 Secure the hard disk drive bracket to the hard disk drive shelf using the screws that you removed earlier.

6 Connect one end of the hard disk drive data cable to the hard disk drive and the other end to SATA1 on the motherboard 

(see Figure 27 on page 62).

7 Connect the power cable to the hard disk drive. 

8 Reassemble the E-45A (see page 86).

9 If you replaced the hard disk drive with a new hard disk drive, install system software (see page 98).

If a startup error displays on the Fiery QuickTouch when you power on the E-45A, check the connections.

10 Verify functionality (see page 86).

DVD drive

The DVD drive is installed in the front of the chassis. The drive is used to install system software and archive data on 

writable media. 

To remove the DVD drive

1 Shut down the E-45A, remove all cables from the back, and then open the system (see page 50).

To access the DVD drive, you must remove the left, right, and front panels from the chassis.

2 Remove the data/power cables from the dual connector on the back of the DVD drive. 

If you are removing the cable assembly to replace it with a new cable assembly, detach the other ends of the cables 

from the motherboard and the power supply.

Important: Avoid striking the DIMMs as you replace the hard disk drive bracket.
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3 Release the front latches on both side of the DVD drive by squeezing the levers, and pull the DVD drive out of the slot.

Figure 35: Removing/replacing the DVD drive

4 If you are replacing the DVD drive with new one, remove the eight screws on the side of the DVD drive and remove 

the ears. 

Set aside the screws so that you can replace them later.

To replace the DVD drive

1 If you are installing the new DVD drive, attach the ears on both side of the DVD drive using the eight screws you 

removed earlier. 

2 Insert the DVD drive into the front panel cutout until the latch snaps. 

3 Connect the data/power cables to the connectors on the back of the DVD drive.

Make sure that the other ends of the cable are connected to the power supply and to Mini SAS on the motherboard. 

4 Reassemble the E-45A and verify its functionality (see page 85).

Restoring and verifying functionality after service

Before you leave the customer site, make sure that you complete the following steps. If you cannot complete a step, 

determine the reason and correct the problem before continuing. For more information, see Troubleshooting on page 105.

1 Latch lever (1/2)

2 DVD drive

1

2
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To reassemble the E-45A and verify functionality

1 Reseat all boards, cables, connectors, and other parts loosened or removed during service.

When routing cables inside the E-45A, make sure that:

• Covers are securely installed after routing cables

• Cable routing does not interfere with the operation of internal components nor interfere with removing or replacing 

components

• Cables are not tangled nor looped around internal circuit boards or components (such as capacitors and resistors)

• Cables do not lie on or against any internal heating element

• Cables do not interfere with opening or closing E-45A panels

• Cable slack is secured with a tie-wrap

2 Restore the E-45A to the upright position.

3 Replace any panels that you removed earlier, as described on page 50.

4 If you replaced the motherboard, make sure that the new motherboard solves the problem that you are troubleshooting, 

and then transfer options to the new motherboard (see page 68).

5 If the E-45A is to be mounted on the furniture with the monitor, see the reassembly instructions that is provided with 

the furniture assembly (page 123).

6 Connect the power cable to the E-45A (see page 18).

7 Connect the E-45A to the printer (see page 21).

8 Print the Test Page and Configuration page.

• If pages do not print, verify that the interface cables are properly connected.

• If image quality is poor, test the printer (see the service documentation that accompanies the printer).

9 Connect to the network (see page 22).

10 Ask the site administrator to download a test job over the network. 

If the job does not print, or has poor image quality, see printing problems and the Troubleshooting sections of the user 

documentation.



Performing Backup and Restore

This chapter provides information about how to back up or restore information to the system. The E-45A ships with system 

software pre-installed on the hard disk drives (HDDs). A factory-installed backup partition is available for restore if there 

is no on-site usable backup. 

You can use three features to create backups and restore the backup images:

• Fiery System Installer

You need to have the System Software DVD 1 to start the Fiery System Installer. This backup captures all settings, 

files, and jobs on the E-45A. You can restore this backup after you replace the HDD.

• Fiery System Restore

You can access Fiery System Restore from the WebTools or Fiery QuickTouch. This backup captures all settings and 

files on the E-45A. You can create a backup and restore the backup when the E-45A is not working. You can also 

schedule the automatic backup. This method does not require you to use the System Software DVD 1. 

See Table 3 for more detailed information on the Fiery System Installer and Fiery System Restore. 

• Command WorkStation and Configure WebTools

This backup captures the customer settings and data. You can restore the custom settings after you reinstall the system 

software or upgrade to the newer version.

Note: The system image does not include VDP/FreeForm resources. To back up the FreeForm masters 1 and 2, save the 

configuration settings as described in “Backing up the system configuration” on page 89.

Table 3: Details of the backup and restore using Fiery System Installer and Fiery System Restore

Backup method Description of backup image Bootable option Possible 

destination

Restore method

Fiery System Restore in 

WebTools or Fiery 

QuickTouch: Fiery System 

Restore > Manual Backup > 

Media selection > Fiery 

factory image

Factory default image, 

manually backed up. Includes 

factory default version of 

software and configuration 

settings.

Does not include print job 

information (print jobs, job 

logs, and job settings such as 

paper size).

Factory default 

image can only be 

saved as a bootable 

image, and requires a 

bootable USB 

device.

USB device only. • Can restore 

directly from 

image

• Fiery System 

Restore

• Fiery System 

Installer
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Backup recommendations

Even though the server maintains a backup you can use for recovery of the factory installation, creating a separate backup 

provides the ability to retrieve customized settings and job information if a recent backup is needed. You can create a 

backup by using Fiery System Restore (from Command WorkStation, WebTools, or Fiery QuickTouch), or Fiery System 

Installer. 

• To create a backup using Command WorkStation, or from a a remote location using WebTools, see “Backing up the 

system configuration” on page 89.

• To create a backup using Fiery System Restore, see “Using Fiery System Restore” on page 92.

Fiery System Restore in 

WebTools or Fiery 

QuickTouch: Fiery System 

Restore > Manual Backup > 

Media selection > New 

Image

Customized image, manually 

backed up. Includes contents 

of C drive (except for items 

excluded by standard 

Windows back up process, 

such as items in recycle bin). 

Includes software updates and 

current configuration settings.

Does not include print job 

information (print jobs, job 

logs, and job settings).

Bootable option 

supported for USB 

devices only.

Can also create a 

non-bootable image.

USB device or 

internal hard disk.

• If bootable, 

can restore 

directly from 

image

• Fiery System 

Restore

• Fiery System 

Installer

Fiery System Restore in 

WebTools or Fiery 

QuickTouch: Fiery System 

Restore > Schedule backup

Customized image, 

automatically backed up. 

Includes same content as 

manually-backed up 

customized image (described 

in previous row).

Non-bootable image 

only.

Internal hard drive. • Fiery System 

Restore

• Fiery System 

Installer

Fiery System Installer on 

DVD: Fiery System Installer 

> Backup Hard Disk Drive(s)

Customized image, manually 

backed up. Includes contents 

of C drive (except for items 

excluded by standard 

Windows back up process, 

such as items in recycle bin). 

Includes software updates and 

current configuration settings.

If jobs option is selected, also 

includes print jobs, job log, 

and job settings (such as paper 

size).

Can create a 

bootable or non-

bootable image.

Bootable image: 

USB device only.

Non-bootable 

image: Network 

location, local 

folder, external hard 

disk, or USB 

device.

• If bootable, 

can restore 

directly from 

image

• Fiery System 

Restore (can 

restore 

images that 

include print 

job 

information)

• Fiery System 

Installer

Additional Fiery System 

Installer option: A factory 

default backup image is 

included on the hard disk 

(Restore from recovery 

partition).

Factory default image. 

Includes factory default 

version of software and 

configuration settings.

Does not include print job 

information (print jobs, job 

logs, and job settings).

If the hard disk is 

still viable, System 

Software 1 DVD can 

boot from this 

factory default 

image.

Included as part of 

original system 

image. If the hard 

disk is crashed, this 

image is not 

accessible.

• Fiery System 

Installer

• Fiery System 

Restore

Backup method Description of backup image Bootable option Possible 

destination

Restore method
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• To create a backup using Fiery System Installer, see “Using Fiery System Installer” on page 94. 

When backing up an existing E-45A installation

• For an existing E-45A installation, first check if a backup image exists either on the server or an external location.

• If a backup image exists, check if it is up to date. Compare the date stamp of the existing backup image to the date of 

the last patch installation. See the System Update log for patch information. See “System Update Log” on page 89.

• If a backup image does not exist, create a new one after installing all available software updates. 

• The backup image may be saved to or found in any of the following locations:

• Local Disk

• USB drive

• External hard disk drive

• Network

• If you do not have a backup with the system settings and jobs, the system can access a preinstalled recovery backup on 

the hard disk drive provided with the E-45A. See “Backing up the system configuration”. 

• If you have a system backup that includes your settings and jobs, you can recover them from your backup media you 

have created with Fiery System Installer. 

• Use a descriptive and consistent naming convention when saving image files (such as date, product name, product 

version, and short description).

After creating a backup image file, it is recommended that you transfer the image file to an external location, such as a 

network location or external drive.

System Update Log

To read a list of applied system updates, you must print a system configuration page. The applied system updates are listed 

in the Configuration page sections: Fiery Updates, Application Updates, and OS Updates. If there have been no patches 

added to the system software, the System Updates sections will not be listed in the Configuration page nor will the System 

Updates be listed in the Fiery Ticker.

Backing up the system configuration

If you back up the system configuration, you can restore that configuration after reinstalling or upgrading system software. 

Important: If you restore the system using the pre-installed recovery backup, the system and configuration will 

be reset to the factory default.

Important: Backed up data can be only restored to the same E-45A.

Important: If you select USB drive or external hard disk drive as a destination, all the existing data in the drive 

will be lost when you create a backup on these media. 
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When you back up the system configuration, you save a configuration file that includes one or more of the following: 

• Fiery System Settings

• Color Settings

• Preflight Presets

• Command WorkStation settings (if you are using a keyboard, monitor, and mouse)

• FreeForm/VDP resources

• Virtual Printers

• Server Presets

• Fonts

• Job Log

Note: Those settings you do not choose are not saved for restore. 

If you cannot create a configuration file, ask the site administrator to archive custom color profiles, preflight presets, 

FreeForm masters, customer-installed fonts, and the Job Log to removable media or a network location.

To save the system configuration using Command WorkStation

1 Ask the site administrator to print the Job Log, Server Configuration page, and Font List (if possible).

2 Launch Command WorkStation and connect to the E-45A with Administrator privilege. 

The default Administrator password is Fiery.1 (case-sensitive), but the site administrator may have changed the 

password.

3 Select Device Center > General > Tools > Backup & Restore, and click Backup > Next.

4 In the Backup & Restore dialog box, select the settings you want to back up.

5 Enter a file name and location, specify if you want to add the date to the file name, and then click Backup.

6 Click Finish. 

To save the system configuration using WebTools

1 Ask the site administrator to print the Job Log, Server Configuration page, and Font List (if possible).

2 Start a web browser and access the E-45A by entering the server name or IP address of the E-45A.

3 From WebTools, select Configure tab > Launch Configure.

4 Log on with Administrator privileges and click OK.

The default Administrator password is Fiery.1 (case-sensitive), but the site administrator may have changed the 

password.

5 On the left side, choose Fiery Server > Backup.
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6 In the Backup dialog box, select the settings you want to back up.

7 Enter a file name and location, specify if you want to add the date to the file name, and then click Backup.

8 Click OK.

Restoring the system configuration

You can restore the system configuration of the E-45A to its previous state using a previously-saved system configuration 

file. For more information about the system configuration file, see page 90.

If you could not save a system configuration file, you must configure Setup. After you exit Setup and the E-45A reboots, 

ask the site administrator to restore any archived settings and files. For more information, see Configuration and Setup, 

which is part of the user documentation set.

To restore the system configuration from Command WorkStation

1 Launch Command WorkStation and connect to the E-45A with Administrator privilege. 

The default Administrator password is Fiery.1 (case-sensitive), but the site administrator may have changed the 

password.

2 Select Device Center > General > Tools > Backup & Restore, and click Restore > Next.

3 Select the item to restore, and click Next. 

You can specify the backup file using the Browse button, or you can select a recent backup.

4 Select settings to restore and click Next.

5 Click Finish. 

To restore the system configuration using Configure

1 Start a web browser and access the E-45A by entering the server name or IP address of the E-45A.

2 From WebTools, select Configure tab > Launch Configure.

3 Log on with Administrator privileges and click OK.

The default Administrator password is Fiery.1 (case-sensitive), but the site administrator may have changed the 

password.

4 On the left side, choose Fiery Server > Restore.

5 Select the reference file and data file. Click Next. 

For more information, see page 90.

6 Select settings to restore and click Next.

7 Click Reboot. 
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Using Fiery System Restore

Fiery System Restore allows you to create a backup of the E-45A for quick recovery later when any problem happens. You 

can restore the E-45A either from images stored on the local hard disk, or from a bootable USB drive. Fiery System 

Restore also provides the feature of creating the scheduled backups.

You must log in to the E-45A as a system administrator to use the Fiery System Restore features.

You can access the Fiery System Restore from the WebTools Home tab, or from Fiery QuickTouch.

To access Fiery System Restore on Fiery QuickTouch

1 On Fiery QuickTouch, tap the Quick launch icon on the bottom-left corner of the screen.

2 Tap the Fiery System Restore icon and log in as a system administrator.

3 Follow the on-screen menus to schedule automatic backups, manually back up the E-45A, or restore the E-45A.

To access the Fiery System Restore from Command WorkStation

1 Start Command WorkStation and login to the E-45A with Administrator privileges. 

The default Administrator password is Fiery.1 (case-sensitive), but the site administrator may have changed the 

password.

2 From Server menu, select Device Center. 

3 Click Tools on the left side, and then click Fiery System Restore. 

The Fiery System Restore will be displayed on a default web browser window. 

To access the Fiery System Restore features on WebTools

1 From a client computer, start a web browser and enter the IP address or the DNS name of the E-45A.

2 Select Home tab. 

The available features are listed under Fiery System Restore section.

You must log in to the system as a system administrator before performing any of the backup/restore process. 

Note: The following tasks describe using Fiery System Restore on WebTools. Fiery QuickTouch uses the same menu 

selections and features for backing up and restoring the E-45A. Refer to the following tasks if you are using Fiery System 

Restore on Fiery QuickTouch.

To setup automatic scheduled backup

1 In the WebTools Home tab, select Schedule Automatic Backup. 

2 Select Enable automatic backup, and select when you want to start the backup process on the E-45A.

Note: The backup process takes more than an hour to complete and it requires the E-45A to be Idle status. If the E-45A 

is not in Idle status, the backup process does not start. 

3 Click Save. 
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To create a manual backup 

1 In Fiery System Restore window, click Backup Now. 

If you have not logged in as an Administrator user, you are required to do so. Enter the administrator’s password 

(default password is Fiery.1), and click Log In.

2 In Backup dialog box, select the media in which you want your backup file saved, and click Continue.

• USB: Select this option when you create a backup on a USB flash drive. If you want to create a backup of the current 

E-45A on the USB flash drive, select New image. You can select Create bootable image to make the USB flash 

drive a bootable media. 

If you want to create a factory image backup on a USB flash drive, select Fiery factory image. The Create bootable 

image option will be automatically turned ON. 

Note: The minimum size for the USB flash drive depends on the actual size of the backup file. You can determine 

the size of the backup file by checking the Estimated size: field in the Create USB Backup dialog box. Prepare the 

USB flash drive with enough capacity. 

Note: Due to a file system restriction, the maximum size of the USB flash drive is 32GB if the Create bootable 

image option in ON. You can use a USB flash drive with more than 32GB capacity if the Create bootable image is 

OFF. 

• Internal hard drive: Select this option when you create a backup on the HDD of the E-45A. You must specify the file 

name of the backup image. The default image name is the server name of the E-45A.

3 Make sure to connect the USB drive to the USB connector on the E-45A.

Note: If the capacity of the USB flash drive is less than size of the value listed in Estimated size: field, the backup 

process will not take place. 

4 Click Continue. 

To restore the backup image

1 In the WebTools Home tab, select Restore. 

2 Make sure that your backup image is accessible from the E-45A. 

If you restore a backup image stored on the USB drive, be sure to attached the USB drive to one of the USB drive on 

the E-45A.

3 Select one of the following restore options:

• Restore from a local image

• Restore from a USB storage device

• Restore from the factory default image

4 If you select a restore from a USB drive, make sure to connect the USB drive to the USB connector on the E-45A. 
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5 Click Continue.

Note: The E-45A must remain powered ON during the backup or restore process. 

To restore the system by booting from a bootable USB flash drive

• Follow the instructions described in “To restore the system from bootable backup media” on page 97. You need to 

connect a monitor, keyboard, and mouse to the E-45A.

Using Fiery System Installer

You can create the system backup or restore from the backup using Fiery System Installer provided with the System 

Software 1 DVD. 

You can perform the following tasks from Fiery System Installer;

• New Installation: Installs the system software from the media shipped with the E-45A. Use this option only when the 

system backup is not available. See also “Installing system software” on page 100.

• Restore using a backup image or the recovery partition: You can restore the system by selecting the backups that 

you created before. If there is no backup available in the system or in any attached devices, you can only perform the 

restore from the recovery partition. 

• Back up hard disk drive(s): Use this option when you create the system backups. You can specify the location of the 

backup, file name, and other attributes of the backups. 

• Platform Utilities: You can perform the backup management tasks from this option such as erasing hard disks or using 

Windows Task Manager to explore the system. 

Note: The Platform Utilities is available only on the monitor. 

Note: You can use the E-45A Fiery QuickTouch to operate Fiery System Installer. You can also use a monitor, mouse, and 

keyboard attached if available. 

Backup with Fiery System Installer

You must back up your system and create a backup image to recover from any unexpected system crashes and the hard disk 

drive failure. 

To create a system backup 

1 Start Fiery System Installer. 

• Insert the System Software 1 DVD into the DVD drive of the E-45A.

• Reboot the E-45A (see page 41).

• When the server finishes the reboot, select the language you use for the backup or restore session.

Important: It is recommended that you create system backups periodically. 
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2 From “What do you want to do?” screen, select “Back up hard disk drive(s).”

3 Enter the backup settings.

Because settings vary depending on the destination you select, make sure that you specify valid settings. 

The Backup settings window appears. In this window, do the following:

• Select a backup destination from one of the following locations: Local Disk, USB drive, External hard disk drive, or 

Network.

• Specify the name of the backup file in the Folder Name field. 

Fiery System Installer creates a folder with the name containing the file name and a time stamp to help you 

distinguish the backup images. The default file name is the server name. The installer automatically generates the 

time stamp.

• If you select, “Include Fiery job files in backup” jobs archived in the server are included in the backup.

• If you select, “Create bootable media,” the USB device or hard disk drive specified as a destination becomes a 

bootable media. Select this option when you want to boot the E-45A from the backup media to avoid the situation 

where the HDD fails and cannot boot the E-45A. See page 95 for booting from the bootable media. Bootable 

media is used for system restoration when a hardware failure occurs.

• Enter a description of the backup.

• If you select Save in the backup settings, the system saves the specified backup setting for a subsequent Load. Only 

the specified setting is saved.

4 If you select USB Drive or External Hard Disk as a destination in step 3, make sure you attach the appropriate device to 

the E-45A. 

5 Click Start backup to begin the backup process.

If there is a need to stop the backup process, press the cancel icon. Fiery System Installer displays a message allowing you 

to restart or shutdown the server. You can specify a backup log to be saved, if desired. 

Restore with Fiery System Installer

To recover from a system crash, you must restore the system with a backup image.

Note: Backed-up data can be only restored to the same E-45A.

Important: If you select USB drive or external hard disk drive as a backup destination, all the existing data in the 

drive will be lost when you create a backup on these media. 

Important: All the existing data in the USB drive or external hard disk drive will be lost when you create a 

backup on these media. 
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To restore the system using Fiery system installer

You will access your backup media (USB drive, local hard disk drive or external hard disk drive) to restore the system. 

1 Start Fiery System Installer. 

• Insert System Software 1 DVD.

• Reboot the E-45A (see page 41).

• When the menu appears, specify a language.

2 If your backup file is stored in the USB drive or external hard disk, attach the device to the E-45A.

3 From “What do you want to do?” screen, select Restore from backup or recovery partition. 

The Select backup source dialog appears. You can choose one of the following: 

• Backup 

If present, previous backups are listed for you to choose. 

• Restore from recovery partition 

This restores the server from a hard disk drive partition to its factory-built settings. 

• Search for backups from this system

This lets you select a backup from a displayed list. Alternatively, you can select Refresh, Import backup history, or 

Search the network for backups.

If a backup image exists, the installer lists information about each backup image:

• The time and date in which you created the backup.

• The location of the backup image: Local Disk, USB drive, External hard disk drive, or Network.

• Alternatively, you can also choose to Refresh, Import backup history, or Search network.

4 Select the source of the backup and click OK.

When a message appears indicating that all the data will be erased, click Continue to proceed the restore. 

Using bootable backup media to restore

Use the following procedure when you restore the system without using the System Software 1 DVD, or when the E-45A 

does not boot from the built-in hard disk drive.

You can restore from the bootable backup media (including the Fiery factory image) created by either Fiery System 

Installer or Fiery System Restore.

Important: Any custom settings you have specified after installation are over-written.
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To restore the system from bootable backup media

To restore from the bootable media, you must have created a backup with the “Create bootable media” option. If you have 

created a backup as bootable backup media, follow these instructions. You can use this procedure to install the system 

software after you replaced the new hard disk drive. 

1 Shut down the E-45A.

2 Attach the bootable USB backup media to the E-45A. 

Make sure to remove any media in the DVD drive. Do not attach other USB devices to the E-45A.

3 Press the power button to turn on the E-45A.

The E-45A will boot from the bootable USB backup media.

4 Follow the instructions on the Fiery QuickTouch display or the monitor (if available) to restore the backup image.

Platform Utilities

Use Fiery System Installer for advanced procedures, such as erasing hard disks, or launching Windows Task Manager. 

These utilities are available when you select Platform Utilities. 

Note: The Platform Utilities is available only on the monitor. 

Erase data from hard disk drive(s)

If selected, the following methods are provided:

• Randomized erase for writing random data to all disk sectors before writing zero.

• Quick erase for writing zeroes to all disk sectors.

Advanced backup management

Allows the Administrator to:

• Load backup settings from a USB drive to apply to system backup images.

• Save or restore backup history files.

• Search for backup images created on a replaced system to be applied to the current one.

Launch Windows Task Manager

Starts the Windows Task Manager. Windows Task Manager displays the programs, processes, and services that are 

currently running on the E-45A. You can use Windows Task Manager to monitor performance or to close a program that is 

not responding.



Installing System Software

This chapter provides information about how to install system software.

The E-45A ships with system software pre-installed on the hard disk drives (HDDs). 

A reinstallation of the system software DVDs will be required if:

• You have replaced the hard disk drive.

• Restoring the system from backup images did not solve the problem you are troubleshooting.

When you reinstall from the System Software DVDs

The following issues apply to the scenario where you reinstall the system from the System Software DVDs. 

• Jobs: When you reinstall system software, all jobs in all print queues and all jobs archived locally on the E-45A hard 

disk are deleted. To save jobs, ask the site administrator to save them to removable media or a network location, so they 

can be re-imported to the E-45A after system software installation. For more information, see Command WorkStation 

Help.

• Job Log: When you reinstall system software, the list of jobs in the Job Log and any jobs in the queues are deleted. The 

site administrator can use Command WorkStation to save a current list of jobs (not the actual jobs) from the Job Log. 

• Fonts: When you reinstall system software, all fonts on the hard disk drives are deleted. Resident fonts are reinstalled 

when you reinstall system software. Any customer-supplied fonts must be reinstalled by the site administrator (see 

Command WorkStation Help).

To determine which additional fonts were downloaded to the E-45A, print the Font List before you reinstall the system 

software and again after you complete the system software installation. Any fonts not listed after installation will need 

to be reinstalled. For more information about managing fonts, see Command WorkStation Help.

• User software: The E-45A ships with preinstalled user software on the hard disk drives. During system software 

reinstallation, you are prompted to reinstall user software (including Command WorkStation) using the User Software 

DVD. 

• Server Configuration page: Before you reinstall a new version of system software, print the Server Configuration 

page. The Server Configuration page provides a record of the customer’s current Setup configurations.

• Backing up and restoring the configuration: All Setup configurations, as well as all custom files and templates 

stored on the hard disk drives, are deleted when you reinstall system software. Always back up the current E-45A 

configuration before you reinstall system software. After the installation is completed, be sure to restore the 

configuration that you saved earlier. For instructions, please see “Performing Backup and Restore” on page 87.

• Compatibility: After you upgrade system software, remind the site administrator to upgrade user software on all 

computers connected to the E-45A. Using old user software with new system software may negatively affect the 

system.
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• Calibration: All calibrated data are deleted when you install system software. If you need to keep the calibrated data, 

export the output profile with the calibration measurement data which you calibrated, export the calibration 

measurement data, and then upgrade the system software. After the upgrade, import the output profile and then the 

calibration measurement data (.cm0 file). 

To export the output profile

1 Launch Command WorkStation and log into the E-45A as administrator. 

2 Select Device Center > Resources > Profiles. 

3 From the Output Profiles list, select the output profile that you calibrated, and click Export. 

4 Specify the location where you want to save the profile and click Select Folder.

To export the calibration measurement data

1 Launch Command WorkStation and log into the E-45A as administrator. 

2 Select Device Center > General > Tools.

3 Click Manage in Calibration area. 

4 In the Calibrator window, select the calibration settings you want to save, click View Measurement, and then click 

Export Measurement. 

5 Specify the location where you want to save the measurement data and click Save.

After you upgrade the system software, follow the procedures below to import the output profile and calibration 

measurement data.

To import the output profile 

1 Launch Command WorkStation and log into the E-45A as administrator. 

2 Select Device Center > Resources > Profiles. 

3 Click Import and select the profile that you want to import.

4 Navigate to the folder where the output profile is located.

5 Click Open. 

To import the calibration measurement data

1 Launch Command WorkStation and log into the E-45A as administrator. 

2 Select Device Center > General > Tools > Calibrate.

3 Select the calibration setting (Plain Paper or Glossy Paper). 

4 In Measurement method menu, select Load measurement from file, and select the file you exported in “To export the 

calibration measurement data”.

You need to select the measurement data that matches the calibration setting you selected. 
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5 Click Open. 

Installing system software

Install both system software DVDs when you replace a hard disk drive or upgrade to the latest version of the E-45A 

software. You can install software from the following disks:

• System Software DVD 1— Fiery System Software for the E-45A.

• System Software DVD 2 and 3—Windows operating system.

• User Software DVD 4—Fiery User Software for installation on the E-45A and client computers.

To install and verify the system software installation

Follow these instructions to complete the system software installation:

• “Before you install or upgrade system and user software” on page 100.

• “Installing or upgrading the system and user software with Fiery System Installer” on page 100.

• “After installing or updating the system software” on page 102.

• “Verify the E-45A operation” on page 102.

• “Before you leave the customer site” on page 103.

Before you install or upgrade system and user software

1 Before you proceed, do the following:

• Ask the site administrator to

• Print the Job Log, Server Configuration page, and Font List, if possible. 

• If any options are activated on the server, you must deactivate them prior to reinstalling.

• Archive and export to an external hard drive, USB storage device or network folder any customer-installed fonts 

and FreeForm masters, if possible.

• Save and export to an external hard drive USB storage device or network folder any custom simulation profiles 

and custom spot color settings, if possible.

2 If you are installing system software, back up the system configuration (if possible).

For more information, see page 89.

Installing or upgrading the system and user software with Fiery System Installer

You can use the E-45A or Fiery QuickTouch to use Fiery System Installer. You can also use a monitor, mouse, and 

keyboard attached if available. 

Important: Remove all dongles and devices, on the E-45A except the keyboard and mouse. If you do not remove 

dongles or devices, the system software installation may fail.
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The System Software installation takes approximately 1.5 hours to complete.

Note: During the installation, you need to access the DVD drive often. Keep the front door open when you install the 

system software. 

Note: If Fiery Impose or Fiery Compose is activated, you must deactivate them before you reinstall. 

• Disconnect the network cable and command interface cable from the back of the E-45A (see Figure 3 on page 19).

If you do not, installation will fail.

1 Insert System Software DVD 1 into the DVD drive.

2 Reboot the E-45A.

Wait while the system boots from the DVD.

3 When the language selection screen displays, select a language.

The language selection screen displays on the monitor and on Fiery QuickTouch. If you select a language on either 

device, you will need to complete the entire installation on that device, and the other device’s screen will be locked for 

the duration of the installation.

4 When “What do you want to do?” screen displays four choices, select New Installation.

5 When “This installation will erase all data on the hard disk drive(s). Continue?” message displays, select Continue. 

6 After copying the System Software 1 DVD contents to the hard drive, eject DVD 1 and insert System Software DVD 2. 

7 After copying the System Software DVD 2 contents to the hard drive, eject DVD 2 and insert System Software DVD 3.

8 After copying the System Software DVD 3 contents to the hard drive, eject DVD 3 and insert User Software DVD 4.

When you eject User Software DVD 4, the E-45A reboots to begin the software installation.

9 Wait while the E-45A complete the installation. This will take about 45 minutes. 

The following steps are for use with a keyboard, monitor, and mouse. If you are not using a keyboard, monitor, and 

mouse, skip to step 15.

10 When the E-45A becomes Idle, click the mouse to show the login screen on the monitor. Enter the Administrator’s 

password and then press Enter.

Fiery.1 is the default password and is case-sensitive.

11 Ask the site administrator to follow the on-screen instructions in the Fiery Setup Wizard to configure the E-45A for the 

customer’s print environment. 

Once the configuration in the Fiery Setup Wizard is done, you must restart the server for the changes to take effect. If 

desired, you can print a Server Configuration page after the restart to confirm the default settings. 

For more information about the Fiery Setup Wizard, see Configuration and Setup, which is part of the user 

documentation.
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12 Wait for the Command WorkStation to start.

During the installation, a localhost connection to Command Workstation is created so when you start the E-45A, 

Command WorkStation starts also.

13 (Optional) Install and activate Fiery Impose.

For more information, see the installation document that accompanies the Fiery Impose kit (Installing the Fiery 

Option). 

14 (Optional) Install and activate Fiery Compose.

15 Shut down the E-45A (see page 41).

After installing or updating the system software 

1 Restore the dongles and devices that you removed in a previous step.

2 Start the E-45A (see page 41).

3 Install any required software patches by System Updates (see page 103).

4 (Optional) Reinstall and reactivate Color Profiler Suite software on the E-45A:

Use the Color Profiler Suite CD to reinstall the software on the E-45A. For complete instructions, see the 

documentation that accompanies the Color Profiler Suite kit.

5 (Optional) Reinstall and reactivate Fiery Impose and/or Compose on the E-45A.

6 (Optional) Set up the proxy configuration if you have a proxy server.

In Configure, click Fiery Server > System Updates > HTTP Proxy Settings, and enter the proxy server information. 

Save your changes and reboot the E-45A.

You can also enter the proxy server information in System Updates application if a monitor, mouse, and keyboard are 

attached to the E-45A. 

For more information on setting up proxy configuration, see Configuration and Setup, which is part of the user 

documentation.

Verify the E-45A operation

1 Print the Test Page and the Server Configuration page.

If the Test Page does not print, verify that the printer interface cables are securely connected and on the correct ports, 

and verify that the printer interface board is securely connected to the motherboard.

If image quality is poor, test the printer (see the service documentation that accompanies the printer).

2 Verify that the E-45A is connected to the network (see page 40).

3 Ask the site administrator to download a test job over the network.

If the job does not print or has poor image quality, see the Troubleshooting topics in Configuration and Setup, which is 

part of the user documentation.
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Before you leave the customer site 

1 Remind the site administrator to do the following:

• Import archived jobs. 

Please note that some archived jobs may not print if you have upgraded the E-45A to the newer version.

• (Optional) Register Adobe Acrobat the first time you use it.

2 Reinstall the following:

• Fonts

• Custom simulations

Note: This upgrade may not be compatible with old user software.

3 Back up the E-45A hard disk drives.

System software installation error messages

If an error message displays when you install or upgrade system software, do the following:

• If prompted, save the log.

• If you are not prompted to save the log, record the error message.

• If the network cable and printer interface cables are still connected to the E-45A, disconnect the cables and perform the 

installation again, starting from “Installing or upgrading the system and user software with Fiery System Installer” on 

page 100.

If you cannot correct the error, contact your authorized service/support center. A log or error message may help to solve the 

problem. Provide as much specific information as possible.

System updates

Advise the site administrator that the System Updates feature available through the Windows Apps screen allows 

customers to schedule and accept installation of certain E-45A software updates from a secure site on the Internet. By 

default, the feature is configured to display a notification on the monitor that software updates are available for the E-45A. 

You can also check for system updates by choosing Start > arrow button > Fiery > System Updates, and then clicking 

Check Now. Depending on how it is configured, System Updates operates manually or automatically. For more 

information about how to schedule System Updates, see Configuration and Setup, which is part of the user documentation. 

Since you can obtain Windows updates directly from Microsoft, EFI does not provide them by means of System Updates.
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Troubleshooting

The E-45A is a server for printers, and is generally part of a configuration that has connectivity to the printer and 

workstations or computers. Problems may occur in one of three areas:

• Inside the E-45A

• In the interface between the E-45A and the printer

• In the interface between the E-45A and the workstations or computers to which it is connected

This chapter identifies the source of common problems that may occur with the E-45A and suggests ways of correcting 

them. This chapter does not attempt to provide troubleshooting information for attached computers such as Windows or 

Mac OS computers, printeres, or extensive networks. Refer problems in these areas to the appropriate service departments 

and network administrators.

If network administrators need to troubleshoot job errors that occur with Command WorkStation, refer them to 

Configuration and Setup for more information, including how to use the Job Error Report feature to collect error 

information to send to EFI Technical Support.

Preliminary on-site checkout

Most problems with the E-45A are caused by loose board or cable connections. This section describes the quick checks 

that you can do to locate and fix obvious problems. It describes how to eliminate any problems with external connections 

to the back of the E-45A, and then addresses checking internal board and cable connections. Check external and internal 

connections before replacing any components. 

Note: Verify that the network is functioning, no unauthorized software or hardware is installed on the E-45A, and no 

problems have occurred with a particular print job or application. The on-site administrator can help you verify these 

issues.

For problems that persist after you check the external and internal connections, this section provides a comprehensive list 

of internal and external checks that may help you fix the problem.

Checking external connections

Before removing the side and front panels of the E-45A to check internal components, eliminate the most obvious sources 

of problems. Make sure that:

• All interface cables to the system are plugged into the proper connectors (see page 50).

• The power cable is plugged into the wall power outlet.

• The LED on the network port is blinking to indicate network activity.

Important: When performing the service procedures described in this chapter, follow the precautions listed in 

page 10.
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Checking internal components

To check the internal components, you must remove the side and front panels of the E-45A.

To check internal components

1 Shut down, and then open the E-45A (see page 50). 

2 Inspect the inside of the E-45A

• Make sure that no foreign materials have been dropped into the chassis. 

• Make sure that the DVD and hard disk drive data cables are connected to the correct SATA connectors on the 

motherboard.

• Look for obviously loose boards and reseat each board securely in its connector on the motherboard. 

• Look for obviously loose cables and reseat each cable connector firmly.

• Make sure that each connector is properly aligned with its mating connector. If the pins are offset from each other, 

the affected board will not function properly. 

3 Reassemble the E-45A and verify its functionality (see page 85).

Inspecting the system

If the system you are servicing does not meet a condition, and it is not obvious what action(s) you should take to fix the 

problem (for example, if the system hangs before reaching Idle), identify the symptom and perform the suggested action(s) 

for the condition.

Important: Before you remove the E-45A panels, be aware of the safety precautions that you should take when 

handling the E-45A. Use standard ESD precautions when handling printed circuit boards and electronic components. 

To review the safety precautions, see page 10.

Important: Before you touch any components inside the E-45A, attach a grounding strap to your wrist and 

discharge any static electricity on your body by touching a metal part of the E-45A.

Important: If your initial checks of the cable and board connections do not fix the problem, you may need to inspect 

the system on a component-by-component basis, as described in “Inspecting the system” on page 106. A 

comprehensive inspection allows you to verify that each hardware component is properly installed and configured, 

and helps you avoid replacing expensive components unnecessarily. 
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Conditions to verify Part and additional page references

When the problem occurs, verify the following: 

• Power cable is connected properly to the E-45A and to the power outlet.

• The E-45A is powered on.

• Chassis fans are operating.

• At least one LED on the network connector is lit.

• All external cables required are present, in correct connectors, well-seated.

• Cables, cable connectors, and mating connectors appear undamaged.

External connectors, chassis fan, and power 

button, “Checking external connections” on 

page 105 and “Checking internal components” on 

page 106.

When the problem occurs, collect logs by doing the following:

1 Log into the E-45A.

You can log into the E-45A with a monitor, keyboard, and mouse, or from a 

client computer with Remote Desktop.

2 On a web browser, type the following URL:

http://10.10.100.2:8080/getlog

Note: You may need to either add the URL to your trusted sites list, or set the 

URL to bypass proxy depending on your network security settings.

3 Save the log file to your local system.

Click File > Save As..., and save the log file as a .txt file.

You can send the log to EFI technical support.

If the problem occurs at power up or reboot, verify that:

• The Fiery QuickTouch is turned on and functional.

• The system does not hang, and no error messages occur before the systems 

reaches Idle.

• After the system reaches Idle, the Fiery QuickTouch LCD touch screen has 

functionality.

If the Fiery QuickTouch does not power up after a reboot, do one of the 

following:

• Restart the E-45A.

• Reboot the E-45A.

• Shut down the E-45A, wait one minute, and then power on the E-45A by 

pressing the power button on the front panel.

• Reset the Fiery QuickTouch: press the reset button on the Fiery QuickTouch 

through the pinhole, and hold the button down for two seconds.

Fiery QuickTouch, page 31.
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• All replaceable parts are: 

• Present

• Properly aligned

• Installed securely

• Installed on the appropriate site

• The correct part for the system 

• Not visibly damaged

• Chassis and contents have not been tampered with (no unauthorized 

additions or changes have been made).

• Chassis does not contain any foreign objects.

Chassis, page 46.

• Motherboard, including components and traces, appears undamaged and no 

foreign objects are evident.

• Each CPU is present, installed in the correct connector, well-seated, and 

appears undamaged.

• Each CPU cooling unit is well-aligned and firmly attached.

• Each fan (including fan cable) is well-positioned, installed in the correct 

connector, and appears undamaged.

• Boards required on the motherboard are present, well-seated, and in the 

correct slots.

• Battery is installed.

Motherboard (with the motherboard replacement 

dongle), page 59.

Important: When replacing the motherboard, 

carefully review the cautions on page 64.

• Each DIMM is well-seated and installed in the correct slot.

• DIMM connectors are not oxidized (reseating removes oxidation).

DIMMs for E-45A, page 70

Each board required is:

• Present

• Installed in the correct slot

• Well-seated

• Appears undamaged

Required cables (if applicable) are:

• Present

• Firmly connected in the correct connectors

• Not visibly damaged

 Printer interface board, page 57

Each CPU is:

• Present

• Installed in the correct socket

• The correct speed (CPU speeds must match)

• Well-seated

• Not visibly damaged

The CPU cooling unit is:

• Ready for efficient thermal transfer

• Well-aligned

CPU with cooling assembly, page 70

Conditions to verify Part and additional page references
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Fan is:

• Properly positioned (not backwards)

• Installed in the correct connector

• Not visibly damaged (fan, fan cable, cable connector, 

and motherboard connector)

Fan, page 76

The power supply required is:

• Present

• Correctly installed

• Not visibly damaged

Cable connectors are:

• Firmly connected

• Not visibly damaged

• Installed in the correct devices

Power supply, page 78

The hard disk drives are:

• Present

• Correctly installed

• Not visibly damaged

Hard disk drive data cables are:

• Present

• Firmly connected to the correct SATA connectors on the motherboard (see 

page 80)

• Not visibly damaged

Hard disk drive power cables are:

• Present

• Firmly connected to the SATA power connectors on the hard disk drives. 

• Not visibly damaged

Hard disk drive, page 80

Conditions to verify Part and additional page references
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Error messages and conditions

To address specific error messages or conditions, see “E-45A error messages and condition” on page 112. Use the table to 

locate the problem or symptom that you want to fix, read about the possible causes, and then perform the suggested actions 

to solve the problem.

If troubleshooting strategies (checking cables and connections, reinstalling system software, and so forth) do not solve the 

problem and you suspect that the hard disk drive or motherboard is faulty, note that it is highly unlikely that the hard disk 

drive and the motherboard are both defective; therefore, avoid replacing both to solve one problem. Always troubleshoot in 

the following order.

1 Replace the hard disk drive and install system software. 

Always replace a faulty hard disk drive with a new hard disk drive. Transferring a hard disk drive from one E-45A to 

another is incorrect and strongly discouraged.

The drive required is:

• Present

• Correctly installed

• Not visibly damaged

• Jumpered as the master (secondary) according to label

• Activity LED lights on power up

DVD drive SATA cable is: 

• Firmly connected to motherboard SATA_6G_0

• Not visibly damaged

DVD drive, page 84

Each cable required is:

• Present

• The correct type

• Installed in the correct connector

• Well-seated

• Not visibly damaged (including connectors)

Hard disk drive data cable, page 80

DVD drive power and data combination cable, 

page 84

Power supply, page 78

If included in the system, the required mouse, monitor, and keyboard are present 

and appear undamaged. The mouse and keyboard are connected to the correct 

ports on the E-45A connector panel.

The cables required are:

• Present

• Installed in the correct connector

• Well-seated

• Not visibly damaged (including connectors)

• Mouse (if applicable)

• Monitor (if applicable)

• Keyboard (if applicable)

• Monitor power cord (if applicable)

Important: Do not replace the hard disk drive and the motherboard at the same time. Doing so in the wrong order, 

without transferring options to the new motherboard, will cause the system to malfunction.

Conditions to verify Part and additional page references
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2 If the problem persists, reinstall the original hard disk drive in the system, and then replace the motherboard.

If replacing a component does not correct the problem, make sure that you reinstall the old component back in the E-45A.

Table 4: E-45A error messages and condition

Symptom Possible cause Suggested action 

Beep codes during Startup

1 beep No error. The E-45A is starting up 

normally.

None 

1 beep, followed by 3 

beeps, followed by 3 

beeps, followed by 1 

beep

Missing, unmatched, incorrect, or faulty 

DIMMs

Check for missing, unmatched, incorrect or faulty DIMMs 

and reseat the DIMMs to remove any oxidation on the 

connector (see page 70).

Startup

E-45A does not start and 

the Fiery QuickTouch 

is black.

Possibly one of the following:

• The E-45A is powered off

• Power cable is not plugged into 

the power connector on the E-45A 

connector panel, or into the wall 

power outlet

• The connector panel power switch is 

in the OFF position

• Fiery QuickTouch cables are not 

connected to the motherboard, the 

Fiery QuickTouch, or both

• Faulty power cable

• Faulty power supply (power supply 

may not be supplying power to the 

motherboard)

• The CMOS jumper is not in the 

default position

• Faulty motherboard (motherboard 

power plane may not be supplying 

power to components)

1 Recheck all cables and connections.

2 Make sure the connector panel power switch is in the ON 

position (see page 50).

3 Listen for the power supply fan and feel for air at the back 

of the unit where the power supply is located.

If air is not coming from the power supply fan, isolate a 

possible faulty power cable as follows:

• Power on using a different power cable.

• Install a new or “known good” power supply.

4 Check the connector panel fan vent and feel for air 

coming out of the back of the system. 

If air is coming out of the power supply fan vent but is not 

coming out of the connector panel fan vent, the 

motherboard may be faulty. You may need to replace 

the motherboard (see page 64).

5 Review the jumper section on page 76 and ensure that the 

jumper is in the default position.
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E-45A is getting power, 

but the Fiery 

QuickTouch is black.

• Fiery QuickTouch cables are not 

connected to the motherboard, the 

Fiery QuickTouch, or both

• Faulty LED cable

• Faulty Fiery QuickTouch display 

module

1 Recheck all cables and connections.

2 Use a different power/LED cable.

3 If the problem persists and you have verified that the 

power supply and motherboard are functioning properly 

as described earlier, replace the Fiery QuickTouch display 

module (see page 54).

Fiery Ticker messages

Please check Fiery 

Hardware.

Possibly one of the followings:

• Network port is physically damaged.

• Network driver is disabled.

• Wrong system software has been 

installed. 

• Wrong BIOS chip is installed on the 

motherboard. 

1 If you installed the system software and this error message 

displays on Fiery Ticker, reinstall the system software 

using the correct system software media.

2 If the problem persists, ask the site administrator if the 

BIOS chip has been swapped from different motherboard. 

If so, replace the BIOS chip with the one from the original 

motherboard. 

3 If the problem persists, replace the motherboard (see 

page 64).

No service dongle Motherboard replacement dongle is not 

attached after you replace the 

motherboard and attempt to transfer 

options to the new motherboard. 

Turn off the E-45A, attached the correct dongle, and 

restart the option and BIOS transfer procedure (see 

page 69). 

Fiery Quick Touch functions

E-45A is getting power, 

the Fiery QuickTouch 

screen is not black, but 

the buttons on the Fiery 

QuickTouch do not 

function.

Possibly one of the following:

• Problem with the Fiery application

• Faulty Fiery QuickTouch display 

module

1 Recheck all cables and connections.

2 Reboot the E-45A.

3 If the problem persists, restore the backup, or reinstall 

system software (see page 98).

4 If the problem persists, replace the Fiery QuickTouch 

display module (see page 54).

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 
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DVD drive

DVD drive is not 

responding, cannot be 

located, or the disk will 

not eject.

Possibly one of the following:

• A disk is stuck in the DVD drive

• Cable connections to the DVD drive 

are loose or data cable is faulty

• DVD drive is faulty

• Motherboard is faulty

1 Press the eject button below the DVD slot on the front of 

the E-45A.

2 If the problem persists, check the cable connections to the 

DVD drive (see page 50).

3 If the problem persists, you may need to replace the DVD 

drive (see page 84).

4 If the problem persists, you may need to replace the 

motherboard (see page 64).

System performance

System performs slowly 

and/or hangs 

periodically.

Possibly one of the following:

• Board or cable connections are 

loose or faulty

• System software is corrupted

• Missing or faulty DIMM(s)

• CPU is overheated or faulty

• Motherboard is faulty

1 Recheck all cables and connections.

2 Make sure that the CPU is firmly seated in its socket and 

that the fan cable is connected to the motherboard. 

3 If the problem persists, restore the backup, or reinstall the 

system software (see page 98).

4 Check for missing or faulty DIMM and reseat the DIMM 

to remove any oxidation on the connector (see page 70).

5 If the problem persists, you may need to replace the 

motherboard (see page 64). 

Clock is slow. Missing or dead battery on the 

motherboard

Replace the battery on the motherboard and update the 

time in the Windows (if a monitor is connected), 

Command WorkStation, or WebTools.page 98

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 
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System performance (continued)

The E-45A hangs during 

the user software 

installation segment.

Possibly one of the following:

• The time and date need to be 

configured in the E-45A BIOS. (If 

the battery was removed from the E-

45A motherboard during service and 

the time and date were not 

configured in Setup afterward, the E-

45A will hang during the user 

software installation segment.)

• User Software DVD is corrupted

• The DVD drive is faulty

• The hard disk drive is faulty

1 Set the time and date in the BIOS:

• Power off the E-45A and remove the User Software 

DVD when it ejects.

• If not already connected, connect a keyboard and a 

monitor to the E-45A.

• Power on the E-45A and immediately press F2 

repeatedly to start the BIOS setup utility.

• Configure the time and date. (To navigate, use the tab 

key and the -/+ keys). 

• Save changes and exit (F10).

• When the E-45A reaches Idle, power off and then begin 

a full software installation again, starting with the 

System Software DVD (see page 98).

2 If the problem persists, obtain another User Software 

DVD and begin software installation again starting with 

the System Software DVD (see page 98). 

3 If the problem persists, you may need to replace the DVD 

drive (see page 84).

If replacing the DVD drive does not correct the problem, 

reinstall the old DVD drive in the system.

4 If the problem persists, replace the hard disk drive (see 

page 80).

If replacing the hard disk drive does not correct the 

problem, reinstall the old hard disk drive in the system.

Network

If you suspect a network problem, keep in mind the following:

• If the E-45A does not appear in the list of printers on the network, another device on the network may have been assigned the 

same Ethernet hardware address. 

• Conflicting network settings may have been configured in Setup and on the customer’s workstation.

• Printing problems may be caused by inappropriate Setup options.

• Application-specific printing errors may be caused by missing or incorrectly placed printer description files.

• System software may be corrupted.

For additional information, see Configuration and Setup, which is part of the user documentation set.

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 
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Network (continued)

Unable to connect to 

the network, or the green 

LED on the RJ-45 

network port is not lit.

Possibly one of the following:

• Network cable is connected to the 

wrong RJ-45 port

• No cable/wrong type of cable is 

connected to the network port

• Network cable or connection is 

faulty

• Network is faulty

• If the E-45A requires a static IP 

address (for example, in a non-

DHCP network environment), it may 

need to be reconfigured. A static IP 

address is deleted when system 

software is reinstalled.

• System software is corrupted

• Network interface on the E-45A 

motherboard is faulty

1 If the problem persists, have the network administrator 

check Network Setup. To configure a static IP address (if 

applicable for the customer site), work with the network 

administrator as described on page 24.

2 If the problem persists, make sure that the network 

administrator has checked other devices on the network.

If other devices are not functioning, the problem may be 

with the network.

3 If the problem persists, restore the backup, or reinstall the 

system software (see page 98).

Corrupt system software may cause the system to hang.

4 If the rest of the network is functioning properly and the 

problem persists, replace the motherboard (see page 64).

System starts up slowly 

then displays one or 

more DHCP error 

messages on the Fiery 

QuickTouch.

Possibly one of the following:

• Network cable is connected to the 

wrong RJ-45 port

• No cable/wrong type of cable is 

connected to the network port

• Network cable or connection is 

faulty

• Network is faulty

• System searches for a nonexistent 

DHCP server because DHCP is 

enabled by default on the E-45A, but 

the customer’s network is not using 

DHCP

• Ethernet interface on the E-45A 

motherboard is faulty

• System software is corrupted

1 If the problem persists, ask the network administrator 

to check Network Setup. To configure a static IP address 

(if applicable for the customer site, as in a non-DHCP 

environment), work with the network administrator as 

described on page 24.

2 If the problem persists, ask the network administrator 

to check other devices on the network.

If other devices are not functioning, the problem may 

be with the network.

3 If the problem persists, restore the backup, or reinstall 

system software (see page 98).

Corrupt system software may cause the system to hang.

4 If the rest of the network is functioning properly 

and the problem persists, replace the motherboard (see 

page 64).

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 
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Printing

Note: Intermittent print quality and color quality problems are difficult to trace. Before you try to troubleshoot print quality 

problems, print a color Test Page to make sure that the printer does not need servicing or adjusting.

Test Page fails to print. The printer is not ready to print. Make sure that the printer is turned on and ready to print.

A problem exists with the connection 

between the E-45A and the printer.

1 If the problem persists:

• Recycle power on the printer.

• Recycle power on the E-45A by shutting down through 

the Functions menu, waiting 10 seconds, and then 

powering the E-45A back on.

2 If the problem persists, replace the printer interface cables 

and board (see page 57).

3 If the problem persists, you may need to service the 

printer.

The E-45A appears in 

the list of printers on the 

customer’s workstation, 

but certain jobs do not 

print.

A PostScript error 1 Make sure that Print to PostScript Error in Setup is set to 

Yes. 

2 Check for error messages on the E-45A output.

An application problem 1 Print a job from a different application to determine if the 

problem is associated with a particular application.

2 Make sure that the connection between the E-45A and the 

workstation is working by downloading a Test Page from 

the workstation, or by printing a simple file such as a 

text file.

3 Resend the problem file.

A print job stalls or stops 

after one or a few pages.

Possibly one of the following:

• A PostScript or application error

• System software is corrupted

1 Cancel the E-45A print job.

2 If this fails to clear the problem, reboot the E-45A.

3 If the problem persists, choose the Clear Server command 

from Command WorkStation.

4 Set Print Cover Page to Yes and resend the problem job. 

The Cover Page will indicate “PS Error.” 

For more information about the PostScript error, 

double-click the problem job in the Command 

WorkStation window. 

5 If the problem persists, restore the backup, or reinstall 

system software (see page 98).

Corrupt system software may cause the system to hang.

Incorrect or faulty DIMM

or faulty DIMM connection

1 Reseat the DIMMs to remove any oxidation on the 

connectors (see page 70).

2 Verify memory amount on the Configuration page.

3 If the problem persists after replacing the DIMM, replace 

the motherboard (see page 70). 

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 



118Installation and Service Guide: Color Controller E-45A

Troubleshooting

Troubleshooting information

You can collect the troubleshooting information when a printing or processing error occurs. The information can be sent to 

technical support for the troubleshooting resource. 

You can create the following information.

• Job Error Report

• System Logs

For the successful problem diagnosis, we recommend that you collect the Job Error Report, System logs, and the Printer 

Device Logs at the same time, 

For the procedure of collecting the Printer device logs, see the service manual of the printer.

Printing (continued)

Color quality is 

inconsistent.

A printer problem Test the printer and perform service, if necessary. See the 

service documentation that accompanies the printer.

Print quality is poor. Possibly one of the following:

• A file or application problem

• A missing or outdated printer 

description file

• The application cannot find the 

appropriate printer description file

• The system is out of calibration

1 Print a E-45A Test Page.

2 If the quality of the E-45A Test Page is good, the error 

condition may be a file or application problem.

3 Make sure that the appropriate printer description file 

is installed. (For details, see Printing from Windows, 

which is part of the user documentation set.)

If the user can print the E-45A Test Page, but cannot print a job from a computer on the network, make sure that the network 

administrator has:

• Checked all components of the network, including cables, connectors, terminators, network adapter boards, and network drivers.

• Activated the network and used it to communicate with other printers.

• Confirmed that the applicable network settings in Setup (such as an IP address, Subnet mask, and Gateway address) match the 

settings used in the network.

Note: EPS file generation is not completely standardized among applications. Some users may encounter problems while printing 

certain EPS files.

Table 4: E-45A error messages and condition (Continued)

Symptom Possible cause Suggested action 
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Job Error Report

Job Error Report contains the important troubleshooting information that the technical support personnel can use to solve 

customer issues. When a user encounters a job error, system fault, or any unexpected output while printing a job, the user 

can generate a report from Command WorkStation. The Job Error Report is a collection of job files, logs, and server 

information in a zip file, and it is available from both Mac OS and Windows versions of Command WorkStation.

Note: The error log entries are overwritten after a period of time. To ensure the error logs contain the relevant information, 

create the job error report as soon as possible after the error is observed. Create the job error report before rebooting the E-

45A and if possible, before any additional print jobs are processed or printed.

To create a job error report

1 In Command WorkStation, select a job in the Printed or Held list. 

Only one job error report can be created at a time. If multiple jobs are selected in Job Center, the Create Error Report 

button is not available.

2 If accessing from a Windows client computer, press Ctrl and right-click the job. If accessing from a Mac OS client 

computer, press Command and right-click the job.

3 In the shortcut menu, click Create Error Report.

4 Enter information about the job error.

a Enter any comments and additional details in the text field. The followings are recommended:

• Date and time error occurred

• Observed error codes, if any

• Description of expected result

• Description of incorrect result

• Steps for how error occurred

• Frequency of error (such as single event, rarely, sometimes, frequently, always)

• Whether the error has occurred with more than one file

• Whether the file selected for the report is the same file that had the error

• Operating system version, if the print job was sent from a client computer

• Version of E-45A user software installed

• Description of any other actions performed on the E-45A during the same time period

b Optional: To include the raster in the report, select Rasters.

The raster can be useful to include if the file is not processed correctly. However, it may exceed the allowed size of 

the report. In this case, it may be useful to provide it separately.

c Optional: To include color profiles in the report, select Color Profiles.

Color profiles can be useful to include if they are custom profiles and the print colors are incorrect.
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d Optional: To include the email log in the report, select Email log.

The email log can be useful to include if the file was submitted by email.

e Optional: To include the native source file in the report, click Add +.

The native source file can be useful to include if the job does not process or print. However, it may exceed the 

allowed size of the report. In this case, it may be useful to provide it separately.

5 Attach any additional related files to the report.

The job error report size can be up to 2GB. If the selections and attachments result in a report larger than 2GB, the 

report must be reduced in order to be completed.

6 Optionally, if any print jobs are considered confidential, remove the job files before sending the zip file to technical 

support.

7 Save the job error report.

System Logs

The E-45A provides the ability to download system logs that can be sent to the technical support for diagnostic purposes. 

The logs are combined into a single, encrypted zip file, which does not contain any original job files.

To download the system logs

1 Access Configure. 

2 Select Fiery Server > System Logs > Download.

3 Specify the location and save the system log file.



Specifications

This section provides an overview of the E-45A features, specifications, and safety certifications.

Hardware features

• Intel Core i5-6500 quad core 3.2GHz CPU (up to 3.6GHz with Turbo Boost enabled)

• Memory: 8GB (2 x4GB)

• An RJ-45 connector for 10BaseT/100BaseTX/1000BaseT Mbs connectivity over twisted pair cable (upper port)

• 1TB hard disk drive standard

• Built-in DVD drive

Physical specifications

• Operating Environment:

• Temperature: +5°C to +40°C

• Relative Humidity: 10%-85% (non-condensing)

• Power Supply Voltage/Frequency Input: 100-240V @ 50-60Hz

• Power Supply Current Input: 100V @ 6A Max.; 240V @ 3A Max.

• Rated Power Consumption: 350W

• Dimensions (Depth x Height x Width):

46.36 cm (18.25 in.) x 52.71 cm (20.75 in.) x 23.50 cm (9.25 in.)

• Weight: 16.56 kg (36.5 lb.)

Networking and connectivity

• Supports AppleTalk and TCP/IP protocols simultaneously.

Note: AppleTalk is supported only for downloading fonts.

Safety and emissions compliance

The E-45A has been certified to meet or surpass the following government standards:

Safety approvals

• IEC 60950-1:2005 (Second Edition) + Am 1:2009 + Am2:2013 and  IEC 62368-1:2014 (Second Edition) 
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• UL 60950-1:2007 R10.14 (TUV NRTL) and UL 62368-1:2014

• CAN/CSA C22.2 No. 60950-1:2007 +A1:2011 +A2:2014 (TUV NRTL) and CAN/CSA C22.2 No. 62368-1-14

• T-Mark by TUV, EN 60950-1:2006+A11+A1+A12+A2 and EN 62368-1: 2014 +A11

• CCC - China

• EAC - Russia

EMI/EMC approvals

• FCC Title 47, Part 15 Subpart B, Class A- NA

• Industry Canada, ICES-003, Class A-NA

• VCCI CIRPR 32-1: 2016, Class A - Japan

• EN55032:2012/AC: 2013 (EU), Class A

• AS/NZS CISPR 32: 2015, Class A

• EN61000-3-2: 2014

• EN610003-3: 2013

• EN55024:2010 (EU)

• CCC - China

• KCC - Korea

• EAC Russia 

• BSMI - Taiwan



Servicing the E-45A with furniture

This chapter describes how to remove the E-45A from the furniture in order to access internal components for service. 

For the assembly instruction on the Fiery NX Station, see the documentation provided with the Fiery NX Station kit.

Procedures

If the E-45A is installed in the optional furniture, you must remove it from the furniture before performing most service 

procedures. 

Figure 36: E-45A installed on the furniture

Removing the E-45A from the furniture

1 Make sure the E-45A is powered off and all the cables are removed from the back of the E-45A.

2 Open the back door of the NX Station and remove all the cables from the connector panel of the E-45A.

3 Pull the server tray of the NX Station out of the stand. 

Replacing the E-45A in the furniture

1 Make sure that all the chassis panels are attached. 

2 Lift the E-45A and place it on the server tray. 

3 Slide the tray into the stand. 

4 Reconnect all the cables. 
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